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Introduction To X-Browse

Introduction

X-Browse is an advanced inquiry tool capitalizing on the reverse engineering technology developed by Databorough over the past decade. The legacy system is interrogated deriving a complete system data model which extracts the application’s inter-file data relationships and dependencies. The meaning of each field and file is interpreted through detailed analysis of the current system’s object programs, screen and data structures. Using this derived information, X-Browse constructs a completely new query and reporting application. X-Browse is ideal for situations where a sophisticated data warehousing tool is too much and basic query tools are too labour intensive. Business Analysts, testers, developers, power users are just some of the typical X-Browse users.

At the same time X-Browse may also be described as a ZERO LOGIC development tool for the creation of client-server and browser-based applications.  No processing logic of any kind (4GL or 3GL) is normally required. Of course, very specialized situations may require Business Rule logic in which case this is specified in a special add-on Shadow Program, but for most applications, this is not needed.

How can a complex application be specified without processing logic? X- Browse accomplishes this through Reverse Engineering. Essentially the necessary functions of the application are deduced by analyzing the structure of its database. The X-Browse method is an iterative one. An initial cut database design is prepared (which might be a reverse engineering extract of a legacy system or might be freshly prepared). X-Browse then automatically constructs a complete prototype application based on the information implicitly contained in this database design. The users review this prototype visually as a working application examining whether the implicit assumptions of their database design correspond to actually what they wanted. Normally they will realize that extra database features or relationships are required and will change the database design accordingly. X- Browse will regenerate the system (a process of minutes rather than days) and this prototyping will be repeated until the created application has almost exactly the functionality required.

At this point the detail design features described in this manual come into play - essentially simply to perfect an already created application that requires minor enhancements to fit the exact requirements.

X-Browse Features  XE "X-Browse:Features " 
The power of X-Browse lies in the following features:

· Data-Modeling.

· Application’s Data Dictionary.

· Direct access to any iSeries data without programming. 

· Initialization of default Views.

· Function designing.

· Exit Programs.

· Work Fields.

· Journaling.

· Business intelligence dynamically created - no canned reports. 

· Interface with Databorough’s X-Analysis.

· Interface with MS Office suite. 

· Security - data is only available to authorized users. 

· Multi lingual support.

X-Browse Configuration Wizard 

To start the X-Browse Configuration Wizard go to X-Analysis>X-Analysis Tools>X-Browse Configuration Wizard.

X-Browse Configuration Wizard configures X-Browse configuration file, xbrowse.cfg. It has five sections (tabs):

· Application settings.

· Library configuration.

· Formatting information.

· Interface.

· Advanced JDBC Properties
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X-Browse Configurator

Application Settings XE " Configuration Wizard:Application Settings" 
This section contains basic settings for the application.

1. IP Address: IP address of the database server. 

2. User: User ID. 

3. Database Type: DBMS type. (DB400 for AS400, MS ACCESS) 

4. User Interface Language: To decide the phrase file to use. Default value is English. 

5. Host code–page: To decide the language in which data from iSeries is displayed. Default is 0037 United States.

6. Max Dependent: Maximum number of dependents to show below Single Record screen. 

7. Logging Level: Level of details of X-Browse errors to be logged. Verbose by default. 

Language: The phrases used by X-Browse for Menus, Tool tips, messages, User actions, User options etc., are picked from a phrase file. X-Browse comes with a phrase file in English - en_GB.properties. The second option is for French and the phrase file containing French phrases is fr_FR.properties. Other options are for Hebrew, Swedish, Spanish and Italian. The button next to it, if clicked, opens the phrase file depending on the language selected. 

X-App Interface: This section contains the information on how the X-App interface will be rendered. Three options are available, namely JSP, JSF and ASP.NET.

Studio Folder: The application to be used for opening the X-App Interface.

Web Server Folder: Location of the web server application.

Show X-Web Components:

Soft Coding of Constants:

Change the language and click Apply. Clicking [image: image2.png]


 opens the properties file for the selected language.

Library Configuration
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X-Browse Configurator – Library Configuration

This section pertains to Libraries to be used by X-Browse. 

1. File: The physical / logical file to use. 

2. Site Library: The site library. Default value is *FUNLIB implying, same as Function Library. 

3. Function Library: Name of the Function Library. 

4. Local Function Database: Check if local X-Ref is to be used. This is to speed up performance by referring to the X-ref library migrated to MS Access using X-Migrate utility supplied with X-Browse.

5. Local Site Database: Check if local Site Library is to be used. This is to speed up performance by referring to the Site library migrated to MS Access using X-Migrate utility supplied with X-Browse.

Library List: Libraries required for executing the User exits, Shadow programs, User Validation routines and Journaling are supplied here. The libraries are separated by a space.

6. Formatting Information XE " Configuration Wizard:Formatting Information" 
[image: image114.png]This section contains formatting information to be used for the application. 

1. Date Format: The format in which the date should be displayed. Default is DD-MM-YY. 

2. Decimal Separator: The character to be used as a decimal separator. Default is “.”. 

3. Grouping Separator: The character to be used as a grouping separator. Default is “,”. 

4. Currency Symbols: The currency symbols to use in the application. Maximum ten currency symbols are allowed. 

	Interface XE " Configuration Wizard:Interface" 
This section contains X-Browse interface information. Check the required options.

1. Double click on grid opens record display in update mode? 

2. Dependents on grid show up in the actions menu? 

3. Menu List of Functions (rather than files)? 

4. Function Menu Links on Record display

5. Show Dependent Data

6. Allow Archive

7. Allow Multi Screen Editing

8. Bulk Email

9. Use Lotus Suite

10. Allow Key Editing
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	11. Maintain Blobs

12. Schedule Jobs

13. Comments AFTER the field on DDS Editor

X-Web Interface settings are also done here. Supply the X-Web Url (Server's IP Address with Port e.g. 192.168.170.1:8080) and the site name (e.g. xan4cdxw).

X-Web Url & Site Name enables X-Web link on Grid and Record Display Toolbars. 

X-Analysis Interface settings are also done here. Supply the location for the X-Analysis folder.
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Advanced JDBC Properties

The JDBC Properties can be set here by specifying the JDBC property Name and Value. E.g. date format = iso.

[image: image116.png]


Each tab has five buttons.

View: This button displays the xbrowse configuration file in read only mode. 

Default Settings: It replaces the current settings with the default settings shipped with X-Browse. 

OK: Saves the configuration settings. 

Cancel: Cancels the changes and exits configurator. 

Apply: Applies the changes to the configuration file and continues in Wizard.

The changes made in the above tabs are saved to the xbrowse.cfg file and used when X-Browse application is run. 

Invoking X-Browse from X-Analysis  XE "X-Browse:From X-Analysis" 
X-Browse can be invoked from X-Analysis, provided X-Browse is installed on the machine. 

X-Browse can be invoked in two modes from X-Analysis:

	Option
	XA Toolbar Icon
	Description

	Invoke X-Browse
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	Invokes X-Browse for a particular LF or PF selected.

(See figure 1 below)

	Invoke X-Browse on Data Dictionary
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	Invokes X-Browse on the Data Dictionary generated by XREV. (See figure 2 below)


These options are also available on X-Analysis right click popup menu.
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Figure 1 – Displaying CUSF – Site by Name records
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Figure 2 – Displaying XPIDS – Primary identifiers records
Grid Display

The Grid display screen primarily lists the data of a physical file in spreadsheet format. The File used decides the View displayed. If physical file name CUSF or the function name AACUSF is specified at the time of entry the display uses the first logical view specified in the function. If the file specified is a logical file CUSFL1, then the view is as per this logical file.

The key field combination is different for every logical file (view) on a database physical file. 

The Grid display comprises:

· A menu bar

· A tool bar

· Position To Panel

· Data grid

· Status bar
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X-Browse Grid Display

Menu Bar XE "Grid Display: Menu Bar" 
[image: image117.png]


Menu bar contains various menus viz., File, View, LookupBy, Actions, Dependents, filters, Design and Help. Each menu item has an associated hot key. User can press Alt key plus the alphabet underlined in the menu item text to invoke that menu item.
File Menu

	New Window

This option clones the current window by opening another X-Browse window with the same function.

Initial Files
This lists the files whose primary Grid functions (AAxxx) have XFUNDEF.STARTR field value = Y. These files are treated as Starter files as they stay on top of relationship hierarchy. Using the Initial Files option, user can drill down or move side ways on the database.

Other Files
Lists the files not included in the above two categories. 

All Files

Lists all files i.e. Initial as well as Other files.

Return
This takes back one screen. 

Exit
Exits X-Browse.
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	View Menu

Refresh 
[image: image118.png]


The Refresh option refreshes the data displayed on the screen. 

Totaling
It provides the grouping facility for the data being displayed on the screen discussed latter.

Totals Only
It provides the grouping facility and displays the keys and the total fields only.
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	LookupBy Menu

If the current physical file has more than one logical view on it, they get listed under LookupBy. LookupBy menu options allow the user to view the same set of data with the different keys. The tick in front of a view indicates that the current Grid display uses that view.
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	Actions Menu

Actions menu has the following options.
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	Display 

Displays the single record view.

Add 

Add option invokes Flat Screen with a blank record where user can enter data and add it to the database. By default, the first alternate function is used for getting the flat screen. 

Update 

Update option invokes Flat Screen in update mode where user can edit that record. By default, the first alternate function is used for getting the flat screen. 

Delete 

Delete option allows deleting a record on the grid. If the user selects a record for deletion, the flat screen of the record is displayed where in s/he can opt for record deletion.



	Dependents Menu
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	Dependents menu shows all the functions (file) that share a key with the currently displayed file i.e. all files that depend for a part of their key on the currently displayed file. Most of the keys in the currently displayed file become a part of the primary key for dependent file with at least one additional key. A record has to be selected on the Grid table to show a dependant file. 

Dependents may also feature under Action menu as options in a separate section, if on X-Browse Configurator Wizard’s Interface tab, Dependents on Record display show up as menu, is unchecked.




	Filter Menu

This is discussed latter under section Working with Filters. 
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	Design Menu

Options here are enabled only if the user has the design authority.

Current Function

Current function option switches the display to design mode so as to customize the current function. 

Select Function 

It brings up a dialog box containing the Grid, Drop-down and Detail-writer functions built on the current physical file. The user can select a function and click on Select to enter into the design mode of the function.

Rename Function

Designer can rename a function. 

New Function

This would create a new function on the current physical file and the current function type. New functions can be created for Grid and Record functions.
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Delete Function

This would display a list of all non-primary functions of the current file for deletion. 

Rebuild Function

Rebuilt Function provides the facility to rebuilt the function, which is currently being displayed. 

User Profile

User Profile can be maintained from the Design menu of the Flat screen or Grid's menu bar. This action is only available to the user having the authority to view the user profiles. 

Report Date Intervals

Report intervals for X-Web reports can be managed here. This has been taken up in separate section.

Apply Theme and Logo

Theme and Logo for X-Web can be managed here. This has been taken up in separate section.

Create Custom Theme

Custom Themes for X-Web can be created here. This has been taken up in separate section.

Define Mail Template

Mail templates are created and maintained here as discussed in Dialogue Management section.

Non-Function Menus

Non-Function menus of X-Web are maintained through this option. 

Help Menu
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Help

Brings up online help related to X-Browse.

About X-Browse

Displays the copyright and version details for X-Browse.

Tool Bar XE "Grid Display: Tool Bar" 
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Tool bar contains shortcuts for frequently used commands.

It also contains some function related to analytical use (Totals, Totals Only) and navigation on grid (First Grid, Previous Grid, Next Grid, Last Gird).

Table given below shows that correspondence between Tool Bar Button and Menu Bar Command:

	Tool Bar Button
	Menu Bar Equivalent
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 Display Button
	Display
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 Filter Button
	View > Filter
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 Totals Button
	View > Totaling
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 Totals Only Button
	View > Totals Only
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 Excel Button
	MS Excel
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 Design Button
	Design > Current Function
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 Maintain Blob Button
	File > Maintain Blob
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 Exit Button
	File > Exit


Totals and Totals Only XE "Grid Display: Totals & Totals only" 
Totals and Totals only provide the facility of grouping the data in a file on the basis of key-fields. When records are displayed on the Grid they are grouped by the change in the selector key (key break). If a function has two selector keys, then the rows in the Grid Display will be grouped by change in the first key. The Total and Totals buttons are mutually exclusive Toggle Buttons.

Field Type attribute of a field if set to TT, identifies it to be a Totals field.

Totals

[image: image120.png]


Totals Button performs totaling of the grid records on the Totals field(s). The Total rows, highlighted in green are inserted at point(s) where the key break occurs. The screen shown below has 2 keys. The Totaling row appears whenever the first or second key changes.
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Totals only 
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Totals Only Button has same functionality as Totals, except that it displays only Total records and no database records on the grid. One record per key break is displayed. 
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Navigation Buttons XE "Grid Display: Navigation buttons" 
The first screen visible in the Grid Display shows only the first set of records in the database file. Other records in the file can be viewed by clicking on the arrow buttons in the top right corner of the display screen.[image: image122.png]
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	The button displays the first set of records.
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	The button here displays the previous set of records in the file.
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	The button displays the next set of records in the data file.
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	The button displays the last set of records.


Transfer to Excel XE "Grid Display: Transfer to Excel" 
Plain Grid, Totals Grid and Totals only Grid can be transferred using MS Excel button on[image: image123.png]


 the toolbar. Clicking on the button brings up the Transfer to MS Excel dialog. User has two options here. To transfer:

· Records in View

· All Records

For best use/performance use filters prior to transferring records.

Reinstate from Archive XE "Grid Display: Reinstate from Archive " 
The Grid toolbar has two buttons for the purpose of archiving records. They are:
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	Reinstate from archive.
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	Leave in Archive.


These buttons are shown if the Allow Archive Reinstatement option is checked on X-Browse Configurator’s Interface tab. 

[image: image124.png]


Open in X-Web XE "Grid Display: Open in X-Web " 
The Grid and the Record screen toolbars have a button to open the current view in X-Web. The button is shown only if the X-Web Url and Site name are supplied on X-Browse entry. The current screen opens in X-Web provided the X-Web Url and site name are correct and the X-Web server is running. 

Position To panel XE "Grid Display: Position To panel" 
Position To panel comprise Position To Button, Position to Text Boxes.
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Position To Textbox

User can position to a record in data file by entering suitable values in one or more position to text boxes and pressing Position To button.
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The textboxes are shown for the key columns on the grid display depending on the key fields of a logical file in use.

In the view above the position to textboxes correspond to the Prospect No and Rep respectively.

Position to Keys

[image: image126.png]


More Keys Button is disabled initially as no key has been removed. The Less Keys button enables the user to restrict the set of records on view. The records having one or more key-field values same as that of the selected record only get listed. The Less Keys button removes the first key field (the left most column). The record(s) having the same value for this field are displayed. 

Say e.g. on the demo application a view (CUSFL5) on Sites file (CUSF) is keyed on three fields, Distributor, Sts and Company Name. The Position To panel has three textboxes, one for each field. The selected record say has Distributor= , Sts=0 and Company Name=Consumer Products Ltd. Pressing Less keys  results in:

· Short-listing the records having Distributor= , i.e. blank.

· The first key column, Distributor, is removed from the grid display.

· Displays the key value in the first position to textbox in read-only mode.

· Enables the More keys button to restore the removed key field.

Pressing the Less key again removes the second key, Status, from the display and further subsets the records having Sts=0 for Distributor= . The second Position to textbox now has 0 in read-only mode. Less Keys button gets disabled.
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Screen displaying records with two keys removed

The More Keys button reverses the process and takes back to the grid status started with.

Data Grid XE "Grid Display: Data Grid" 
Data is displayed as a grid of records. 
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Screen displaying records in a grid

Status Bar XE "Grid Display: Status Bar" 
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States bar shows current status of grid display. Its divided into four parts: 

· Message Area – This is reserved for the Success, Error, Warning and Information messages generated while running X-Browse. The color convention for these messages are:

· ERROR MESSAGE - Red

· WARNING MESSAGE – Black

· SUCCESS & INFORMATION MESSAGE - Black 

Multi-line messages are pipe (“|”) separated. User can copy these messages using right-click popup menu on message area.

· [image: image127.png]


Second part shows the Database library and current physical file name.

· Third part shows the X-Ref library and current function name. A right click on this region pops up the library list in use for the current X-Browse session.

· Fourth part displays the IP Address of the Server connected to. 

Record Display

The Record display of a file can be reached by specifying Record Function name (ZAxxx / UAxxx of type R / U) in X-Browse Entry Dialog. Display button on grid‘s toolbar also takes the user to record display.
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Components of Record display are:

Menu Bar XE " Record Display: Menu Bar" 
[image: image128.png]


Menu bar contains various menu items as File, View, History and Help. 
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File Menu

Options here are same as that on Grid.

View Menu
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Dependent Function

Check this option to display the dependents (attached functions) associated with the Record display. The dependents grids are displayed in the lower half of the display.

Comments
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Comments are Optional. Check it to display the comments associated with the record. The comments are displayed in the lower part of the display, below Dependents. Refer Dialogue Management section for more details.

Refresh

Refreshes the single record display.

Action Menu

Options here are same as that on Grid.

[image: image131.png]T | I
§_Prospect No % Rep



History Menu

This menu is relevant to AS/400’s journaled data files.

Previous Entry

This menu option (Previous Journal entry button) brings up the single record display of the previous journal entry (with reference to the journal entry currently displayed in the single record display).

Next Entry

This menu option (Next Journal Entry button) brings up the single record display of next journal entry (with reference to the journal entry currently displayed in the single record display).

Grid

This menu option (Journal grid button) displays all the journal entries of the record in the form of a table on the lower half of the display. Anyone of these entries can be selected for viewing in the Single Record view by double clicking the row. 

Single Record

This menu option (Journal Single Record button) takes the user to current function’s Single record display from the journaled one.
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Help Menu

Options here are same as that on Grid.

Tool bar XE " Record Display: Tool Bar" 
Tool bar contains buttons for frequently used command viz., Return, Design, Journal Previous Entry, Journal Next Entry, Journal Grid, Journal Single Record, Exit, etc.
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Table given below shows that correspondence between Tool Bar Button and Menu Bar Command:

	Tool bar button
	Menu bar equivalent

	[image: image41.png]


 Return Button
	File > Return

	[image: image42.png]


 Design Button
	Design > Current Function

	[image: image43.png]


 Previous Journal Entry Button
	Journal  > Previous Entry
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 Next Journal Entry Button 
	Journal  > Next Entry
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 Journal Grid Button
	Journal  > Grid

	[image: image46.png]


 Journal Single Record Button
	Journal  > Flat Screen

	[image: image47.png]


 Exit Button
	File > Exit


Record panel XE " Record Display: Record Panel" 
Record panel displays selected record from the grid in single Record display. The display mode shows the record in read only form.
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Note:

The Record display presents Label-Value pairs for the current file’s field(s). Normally values are shown in the text field, but in the following cases they are shown as:

· Drop-down if the field is a code field in front of field label. This drop-down contains the list of possible values for that field.

· Checkbox if the field is a YES-NO field. In this case the size of the field will be one character long. Selected checkbox means Yes where as unselected means No.

Dependents panel XE " Record Display: Dependents Panel" 
Dependents panel is displayed when the View > Dependent Functions menu option is checked. The panel appears in the lower part of screen and dependent records are displayed as grid. If the number of dependents exceeds the allowed number of dependents (setting in Configuration Wizard), a drop list labeled More dependents appears on the tool bar. This drop list is used to view additional dependent grids.

[image: image49.png]Name.

Customer

Bark

Bertahiste & Compary Lid facer asacs
TauReg Co— StatementAccout [accz Fores fr
Bark Ave m Reated Accaunt [recss Tems o
Cusip o |G Date Loaded Fa-oe-00 SiDse 5
fep EETTDE ChoDate Py Int g
Distibutor o7 ~|Dasborsuch Tech Last Sale [ra-05-00 CiGuariee [y
CreditLimit Mooizso.oo Date Last Pay Ma-oe—00 B0 [t
Amt Last Sale Z500.00 Date Last Stmt Ma-oe—00 Lang &
LastPay 2500000 CurPay o-00
Posete [ oot Compayid Gl 0.0
Curent At Gaesson Cun Sls 6540, 00
00eys [rez0r 01 Curr Cost eese7.00
050Deps se0-00 Yid Sales esaren 21
090Deps rez.00 LastYear s [rez1avs.00
120Days o0 Baence R

Vaidate Update. Update & Bietum | Concel |
. Contact Header | 02 Prfcts | 03 TranactionHiso |
PostonTol [~ | >
7B CTivech B AR e s [ [ e en el Post ade
140199 T T Cusfell  HamoNioss FD 000 HlesonenRoad Cradey Healh Warky WestMidands 864708
140139 NwD 2 Tawrefl  Hamollioss FD 000 HalesowenRoad CiadeyHeath Waley WestMidlands B4 7B
110501 MIT | 125470 RefWWES76  Hamoh rass 000 | Halesowen Road | Cradey Healh Warky West Midands | B4 7JB
130501 MIT 879 Myoder  Hamll oss 000 Halesowenoad  Cradey Heath Warky West Midands B84 75
180701 ST | 125479 om
tecord in Update mode. MANACDEM/CUSTS MANACDXW/ZACUSTS




[image: image133.png]Mo« »




Dependent grids, like normal grid display, also have Position To Panel, Single Record display and Navigation Buttons..

Descriptor Dialog  XE " Record Display: Descriptor Dialog" 
[image: image50.png]


 The Descriptor button appears for those fields, which form the least priority key in the refers-to relationship with the secondary file and the Code field attribute for the field is set to N.
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The button click presents descriptor dialog displaying records of the secondary file. Alternatively, it can be invoked by pressing F4 key when on the field having the descriptor. The dialog helps the user in selecting/updating values for the foreign keys of the current record. Double-click on the row or select the row and press Select button to select the values from secondary file to the foreign keys. The dialog has position To panel and Navigation buttons as on the Grid display. Display button opens the selected record in Single Record Display in a new window.

Work with Filters

At times it might be required to focus on a particular subset of the data available in the grid; for example it might be necessary to view only those customers who live in UK. Filters can help solve such problems.

Filters may consist of various criteria – the example above to find customers in UK consists of only one criterion. A filter based on multiple criteria would be needed to find UK based customers whose last purchase was after the 1st of January 2000.

Creating Filters XE " Work with Filters :Creating Filters" 
Filters are only available on grid screens. To work with filters the user would need to select the Filters > Filter option from the menu bar or simply click the filter button on the toolbar. [image: image52.png]



This brings up the dialog shown below:
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The two blank rows (one of which is highlighted dark-green) at the top are where the filter criteria can be specified. Each row specifies a separate criterion. All the criteria chained together specify a filter.

Let us create a sample filter by example:

In the image-snippet of the filter dialog shown above, we see the user selecting a field. This field can be any one of the primary fields from the grid on which the filter is to execute.

The next column indicates the operator for the criterion. A rich set of operators is available for use:

[image: image134.png]


LT - The Less Than operator: selects records in the database function, which have a value less than the value in the VALUE field.
LE - The Less than or Equal To operator: selects records in the database function which have a value less than or equal to the value in the VALUE field.

EQ - The Equal To operator: selects records in the database function, which have a value equal to the value in the VALUE field.

GE - The Greater than or Equal To operator: selects records in the database function, which have a value greater than or equal to the value in the VALUE field.

GT - Greater Than operator: selects records in the database function, which have a value greater than the value in the VALUE field.

NE - The Not Equal To operator: selects records in the database function, which have a value not equal to the value in the VALUE field.

LK - Like: The like operator is used to retrieve those records from the database function, which match with the search string specified in the VALUE field. This operator can only be applied to character fields; however one can search for numeric values on text fields. The search string for the VALUE field is composed of any specific string along with a combination of wildcard characters: % and _ .The character % can stand for a string of any length in the search string, _ can stand for any single character. The following combination of these characters with specific strings (here denoted with the string ABC) is possible for the search string:

	ABC%
	String ABC followed by any String

	%ABC
	String ABC preceded by any string

	%ABC%
	String ABC preceded and followed by any string

	ABC_
	String ABC followed by any single character 

	_ABC
	String ABC preceded by any single character

	_ABC%
	 String ABC preceded by any single character and followed by any string 


BT - Range: - This operator is used to identify a range of values for the filtered field. Two values are required in the VALUE column for this operator – a maximum and a minimum value. These values need to be separated by a comma.

IN - In: If there is a particular set of values identified that needs to be used to filter the operated field by then the IN operator is the appropriate operator to use. All the values occurring in the set, must be specified in the VALUE column and must be separated by commas.
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The VALUE column pertains to the value the operator uses to filter the field. Make sure that the value specified matches the type of the field on which the criteria is based. In this e.g. it would be erroneous to put a value like ‘bad value’ in the value column simply because the field ‘Cus. No.’ is a numeric field.

The entire criteria shown above now translates to the following query:

show me those customers whose customer no. is less than 10.

It is possible to add more criteria to the filter. Move on to the next row. Notice also, that in doing so, a new blank row gets created automatically for the next criterion. The last criterion row is always set to create a new criterion row as soon as it is activated; hence the number of criteria you append to your filter is theoretically limitless.

[image: image55.png]Field Name Operstor Value Bodlean
Cus. No. Less than(LT) 10 [
Cus. No. Choose operalor





Criteria are chained together within a filter using a Boolean operator. In plain English a Boolean is either an AND or an OR. Hence, you could say…

show me those customers whose customer no. is less than 10 OR whose status code is equal to 3
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…which is quite different from saying…

show me those customers whose customer no. is less than 10 AND whose status code is equal to 3.

In this manner you may chain a number of criteria rows together.

If by mistake you create a criterion, which you realize midway that you don’t want incorporated in the final filter, then you can simply select the row, right-click and select the delete option in the pop-up menu that comes up. Similarly you may add new criterion rows above and below the selected row.
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X-Browse will ignore all incomplete criteria in the process of filter compilation. Hence, in the figure above, the rows highlighted yellow will be ignored.

After you have created your filter, you may execute your filter by using the button at the bottom of the filter dialog marked ‘Execute’. If the filter compiles without error you should see the grid again, however, the rows shown will exactly correspond to your filter request. All rows not matching your request will not be shown.

The Date fields can use values like *CURRENT (Current date), *CURRENT ± n days.

Stored Filters XE " Work with Filters :Stored Filters" 
Sometimes it may be advantageous to save filters for reuse at a later occasion. This is convenient if you frequently need to make the same queries on the data. Instead of recompiling the frequently used filters every time, you can get X-Browse to save them for later use.
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After constructing a filter following the normal steps outlined previously, you may choose to store your filter in the advanced panel by entering some descriptive text for the filter description and clicking on the Create New Filter button as shown above.

On executing the newly created stored filter, you should notice two things about the resulting grid (other than the fact that the rows have been filtered in accordance to the new filter). The title for the grid should have changed – the filter description will be appended to the title (circled in yellow above). 
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Secondly, and more importantly, you should be able to see a new entry in the Filters sub-menu with the description of your filter (in our e.g. - the last entry in the sub-menu highlighted in green). From now on whenever you browse through this particular grid function – you can quickly and easily invoke the new filter by choosing: Filters>’xxxxx’ (where ‘xxxxx’ is the description for the filter) instead of going through the filter dialog.

Once a filter has been applied on a grid, all actions like bulk mailing, totaling and printing will use the filtered set of records and not the complete set. To be able to see the complete set again, either choose Filters>Remove Filter from the menu-bar or click on the Remove Filter button at the bottom of the filter dialog.

Filter maintenance XE " Work with Filters :Filter maintenance" 
You may review your stored filter at a later occasion. Fire up the filter dialog. Near the bottom of the dialog you should see a drop down field entitled  Filter, click on it and choose the filter you want to review from the list of available filters.
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As soon as you choose the filter, the criteria rows above should change to depict the criteria stored in the filter selected.

At this point you may choose to change the filter by removing previously specified criteria, changing them or even adding new criteria.
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Make the required changes to the criteria rows and click on the button marked Save. Notice in the example above that the filter description has also been changed while updating the stored filter. In the example the filter has been changed from the query…

show me those customers whose Prospect no. is more than 10 

..to…

show me those customers whose Prospect no. is more than 20 
Fields from the secondary file can also be included in the Filter criteria provided they have been included in the function. The fields show in Field Name Drop list as FILE.FIELD.

Group Filter

Group filter, as the name suggests, is a collection of filters specified on various files of the application database. They are primarily used to selectively migrate or archive Application data.

X-Designer allows creating and updating Group filters. Group Filters option is available under the Filters menu on Grid Display. This option presents the Group Filter Manager.

The Manager has two sections: 

· Section one has a table listing the Group Filters 

· Section two is the Edit panel to add new group names or update/delete the existing ones 
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The first section lists the Group filter name and its description. The first row defaults to "Add New filter".

The edit panel allows adding of the Group name if the first row is selected on the list above. Any other row selection on the list opens that Group name in update mode.

The edit panel has four buttons: 

· Add 

· Update 

· Delete 

· Cancel 

Add Button is enabled only when adding a record. Update and Delete buttons get enabled when working with an existing record.

Update Filter Details XE " Group Filters :Update Filter details" 
To add the filters to the Group Filter Name, pick Update Filter Details under Group Filters
This presents the Filter dialog.
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 Pick the Group Name from the dropdown to which filters are to be added. Adding filter criterion is same as discussed in Work with Filters above.

Display Group Filter XE " Group Filters :Display Group Filter" 
In order to display the various filters a Group Filter Name holds, pick the Group filter under Group Filters. This presents the list of filters in a Group Filter.

The list details each filter on the selected Group Filter 

· Filter Description - The format is "Physical file"."Field" "Operator" "Value" "AND/OR".

· User details who added the filter.

· User details who changed the filter, if any.
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Dialogue management

User can attach notes/comments to a particular record in a data file. They are shown below the single record display. Comments can be grouped under specific headings created for the purpose.

Multiple comments can be added/updated at one go.

Working with Comments XE " Dialogue management: Comments & Notes" 
Comment heading XE " Dialogue management: Comments & Notes: Heading" 
X-Browse creates a default heading named General. New headings can be created and renamed. 

Add heading

A new heading for the comments can be added by entering the desired title for the heading in the space provided besides the label New Heading. Press Enter to create new topic which gets added to the comments panel.
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Rename heading

To rename a heading the user should click on the desired heading, which makes the heading editable. Press Enter to save the changes. 

If the current user is not the owner of a particular heading then that heading is not editable. Such headings can be distinguished by their grey background. 

Delete heading

User can delete a particular heading by using [image: image64.png]


 Delete Heading button next to it. This button deletes the heading and comments under it. The user is not allowed to delete the heading owned by another user.

Add comment XE " Dialogue management: Comments & Notes: Add " 
To add a comment the user should type the comment in the text area of the blank comment provided for a particular heading.
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Press Enter to add comment. The comment gets added and brings up a blank comment on the top of the comment added under a particular heading. 
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New Comment Added to a record

Update comment XE " Dialogue management: Comments & Notes: Update " 
To update a comment the user should click on the comment to make it editable. Press Enter to apply changes to the comment. The comments owned by another user have gray background and cannot be edited. 
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Comment for a record updated
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Replying Queries XE "Dialogue management:Comments & Notes :Replying" 
For administrator to reply to queries, s/he has to start X-Browse using Member information function (AAXMBRINFO) built on Member information file (XMBRINFO).

On an active X-Browse session, File menu has Data Dictionary Files item. This lists Data dictionary files in a dialog shown below. One of the entries, User Details (XMBRINFO), is selected. Click OK to bring up the list of users and their information.

Single Record display can be taken on any user. The display brings up the comments panel having comments written/addressed to that user. The administrator can reply to memos posted by the selected user here.

Interface with Microsoft Office XE " Dialogue management: Comments & Notes: Interface with Microsoft Office " 
Each comment on the Comments panel has the following buttons attached to it. These are user interface to Microsoft Word and Outlook.
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Interface to MS-Word

This provides the functionality to create/view a word document of a particular comment according to the template provided. These documents are stored in the documents subfolder of the X-Browse installation folder.

Create document

To create a word document user has to press the create document button corresponding a particular comment. The document is prepared according to the template provided and opened in Word. 
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Word document created for a comment

The comment’s text is taken as the body of the letter. Comment owner is treated as sender of the letter.

View document

User can view a word document related to a particular comment already created by pressing the view document button. 

Mail

To be able to use X-Browse’s mailing facility it is required to have MS Outlook properly installed and configured on your machine.
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Mailing primarily depends on the field processing type. This is available to the application designer under the Screen Layout tab by clicking the Properties button related to the field whose processing type you want to change. This should bring up a dialog as shown below. The property we are interested in is the Field Processing property – whose range of values is available as a drop-down:

The range of values is extensive and includes values like:

· (EM) Email

· (SL) Salutation

· (FN) First Name

· (LN) Last Name

· (A1) Address 1

· (A2) Address 1

· (A3) Address 1

· (PC) Post code

· (CY) Country

· (NM) Full Name

…. and many more.

Each value is a two-character code which is significant as you will see later on.

X-Browse allows the user to send e-mail messages from within the application. The messages can contain auto-filled values from the database and hence is a convenient method to generate form-filled general messages to many recipients.

X-Browse uses a template mechanism to create these general e-mails. Templates contain tags that when processed are replaced by data values retrieved from the backend database. In fact these tags are nothing but markers for fields whose field type property has been set by the designer as mentioned above. Each tag has an associated two-character code, which links it to the database field.

Templates created can be used immediately to send e-mails or may be even stored for later use.

There are two ways to generate mail depending on the circumstances and requirements. You may:

· Opt to send a particular message to a number of recipients  (Bulk mail) Or

· Send a message to a specific recipient (Individual mail)

Bulk mail XE " Dialogue management: Comments & Notes: Bulk Mail" 
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Bulk mailing is available from the grid screens only. You may invoke it by using bulk email toolbar icon: [image: image70.png]



Click the Design > Define Mail Template option.

This brings up the dialog shown below:
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The two main areas marked above are:

1. The email composition area

2. The tag palette

The email composition area has:

· To field for additional email addresses, besides field marked as EM, if any.

· Subject field to hold the subject of the mail.

· Body area for mail contents.

However, many a times, when you are sending bulk emails you may like to send customized messages depending on the customer’s record. To do this you use the tag palette. Each button in the tag palette corresponds to a specific tag which links to specific columns/fields on the customer’s record. These tags when placed in the emails you write will later expand to the actual value according to the record. When sending bulk email over a number of customer records you can use this feature to generate specifically targeted emails to your customers. We will now proceed to demonstrate such a scenario below:
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In the email above you will notice that there are quite a few yellow highlighted codes. These are various tags that the user entered into the email. To enter tags you must click on the appropriate tag button on the tag palette on the right. The buttons are titled with the relevant tag codes, however, by hovering with your mouse over any particular tag button you will see a short description of the tag, for e.g. the tag <NM> stands for: Name and the tag <EM> stands for Email.
Some of the tag buttons on the palette are disabled. This indicates that no field corresponds to these field-processing types.

Once you have finished composing the email you may click on the button marked Save at the bottom right of the dialog. The dialog’s contents will change.

The dialog now shows the contents of the first email that may be sent. You must decide what to do with this email before X-Browse will go on to the next email.
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The four buttons at the bottom of the dialog indicate your choice of actions:

Send mail: Clicking this button indicates that you approve of the email and that it is fit to be sent – the email will then be automatically sent to Outlook from where it will be either sent out immediately or queued for sending later on (depending on your Outlook settings).

Edit mail: This indicates that you would like to do some fine-tuning – X-Browse will still send the message on to Outlook, however Outlook will open a Compose message window with the text of this message filled in automatically. You can make your changes and send.

Skip mail: This indicates that you want to skip sending this particular message.

Cancel all mails: Indicates that all remaining messages are not to be processed. However all messages sent before this action are sent.

The dialog keeps repeating itself for each and every record available on the grid screen. Thus you can send bulk mail corresponding to each record on the grid. 

In fact you can achieve quite powerful mail automation by using appropriate filters on the grid first before resorting to bulk mailing.

Individual mail XE " Dialogue management: Comments & Notes: Individual Mail" 
Individual mails may be sent from the flat screen comments panel. To send an individual mail you must click the sendmail icon on the right of the comment. This should again bring up the list of email options, as does the bulk mail icon:
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Unformatted Mail uses no template and opens the mail in the composer of the Email client.

Clicking on the Design ->Define Mail Template option brings up the dialog depicted below:

[image: image75.png]Define Mail Template:

To

|
Subject: 5'

M | MT>

AL

Mail Template:

Avaible templates: [New Template

Templte nare:

= \ =





This is similar to the bulk mail dialog. There are three additional tags marked in red.

· <MH> - Memo header text is not a valid field type like the other tags. It represents the first 100 characters of the comment on which the mail is invoked.

· <MT> - Memo Text picks the entire comment text for an individual mail.

· <AL> - Add Link is for X-Web use only. This adds the page link from where the mail originates.

<MH> and <MT> tags can be used in Subject field. <AL> can only be used in mail’s body.

Compose your message as explained above for bulk mails.

When sending the message you will notice that the dialog here too is slightly different, specifically the buttons:
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The button options are simpler since there is only one message to send as opposed to many messages in the bulk mail scenario.

Stored Mail templates XE " Dialogue management: Comments & Notes: Stored Mail Templates" 
Sometimes it may be advantageous to save your mail templates for reuse at a later occasion. This is convenient if you frequently need to send the same mail format on repeated occasions. Instead of recomposing the message every time, you can get X-Browse to save them for later use.

Templates are stored on the application database. To be able to create new templates you need to have design authority. However, to use templates to create messages no permissions are required. In fact, in the examples above when the bulk email icon or the individual send mail icon was clicked the menu showed other options besides the Define Template option:
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In this example there are two stored e-mail templates available. Clicking on any of them will invoke the corresponding mail template. The message composition stage will be skipped and the system goes directly into the send stage. This is a quick and easy way to send repeatedly used messages.

As mentioned above, if you are a designer you may store mail templates on the system for retrieval by you or other users. As a designer the email composition dialog that comes up when you choose to compose a Define Mail Template is slightly different from the ones shown below:

After composing your mail, you should enter an appropriate name for your email template in the Template name text box. 
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As soon as you do so the Save button will become enabled. Click the button to save the template. As soon as this is done the template becomes available in the drop down titled Available templates. Now at a later occasion you can reload this template by choosing the template from the available templates list. As soon as you do so you will notice that the email composition area will be updated to show the saved template. You can then continue to use this template or even change its contents slightly, update it, even delete it or even save it as a new template.

Interface to Microsoft – Outlook

Send mail XE " Dialogue management: Comments & Notes: Send Mail" 
User can mail a comment to a specified e-mail id by using send mail button next to a comment. The comment text is treated as text for message of the mail and the Comment owner becomes the sender. It opens up MS Outlook new mail editing page. 
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Comment being sent as mail

View mail XE " Dialogue management: Comments & Notes: View Mail" 
User can view mailed comments by using view mail button of a particular comment. If this comment has been mailed and exists in MS Outlook’s Sent Items folder, it opens MS Outlook new mail editing page and displays the mail. If the selected comment has not been sent then a No Record Found message is displayed.

Function Designer

Physical files in an RDBMS have relationships with other files. These relationships revolve around foreign keys, where a file holds a reference to the key of another file. In X-Browse terminology, a physical file has dependent file when other files holds its primary key - i.e. a One to Many relationship. A file has an owner file when it holds the primary key another file - i.e. a Many to One relationship. In this way, the data-model describes all of the relationships between the files of a database.

The Data Modeling process exacts the data-model of a legacy application and uses it as the basis of the functions. Each function maps the relationships of its underlying physical file in its own relationships with other functions; i.e. a function has a dependent function when the underlying file has a dependent file. Thus, the functions internally describe the complete data model of the database. X-Browse uses this information to move from file to file and record to record using only the function definitions.

Therefore, functions generated in the Data Modeling process are at the core of the X-Browse product. The functions contain all the information from the reverse-engineered legacy application and X-Browse uses them to provide all the features of the original application on a web browser.

Legacy applications provide the user with different Screens, each of which produces different functionality and access to the database. X-Browse functions are the modern counterparts to legacy-ware Screens; each function is an individual meta-program that replicates the look and functionality of one legacy Screen. Functions are stored as database records and X-Browse is designed to read function data and produce an application with capabilities as specified. Together all the functions combine to replicate all of the Screens from the original application. 

A function is built on a particular physical file and supplies services associated with that file. Each function contains a portion of the logic from the original application specific to the physical file that the function is built upon. With the information from a function, X-Browse can display, update, insert and validate data from a particular physical file. It can also call associated validation or auxiliary programs to extend the capabilities of the application. 

The functions include links to other functions with related physical files. This implies that X-Browse is intelligent enough to move from a record in, e.g. COMPANIES file, to related records in the EMPLOYEES file. Together the functions combine to offer a network of functionality that emulates the full capabilities of the original legacy application. As each legacy-ware Screen links through to other Screens, so X-Browse functions link to other functions.

Many different functions can be built over a single physical file. Typically, there are at least four functions per file which X-Rev process generates. Functions can be devised to offer different services to a physical file - some excluding certain information, some with extra functionality, etc. This means that functions can accomplish specified tasks for specific users thus limiting the access to sensitive data and facilities. By customising a function for particular tasks, the whole application becomes much more usable. The equivalent in a legacy application is that one Screen permits certain access and actions to and on a physical file, whereas others will provide a more restricted interface.

X-Browse uses four types of function, each of which is designed to offer a different kind of interface and service to the user:

Record Functions

These functions draw together all of the resources for a single record. They display the fields, related records, images and services available for a particular record. This type of function is vital for gaining detailed access to single records. X-Rev generates functions starting with UA and ZA and having Function Type U and R respectively. These functions are Flat screen functions. E.g. UACUSTS and ZACUSTS i.e. UA/ZA<Physical Filename> are flat screen functions on Physical file Customers (CUSTS).

List Functions

These are designed to offer a summary view of multiple records. These are typically used to display non-numeric data, perhaps with other resources such as images. List functions are helpful because they enable users to browse and navigate through the records of a file. Functions with WA prefix to physical filename are List functions of Function type L. E.g. WACUTS.

Grid Functions

These functions are designed to offer a summary view of multiple records. Grid functions display tables of information and mainly used for numeric data. The user can add and update records in the grid as he would with a spreadsheet. AA prefix and Function Type G makes a Grid function. E.g. AACUSTS. 

Drop Down Functions

Drop Downs are stripped-down functions that are used for updating foreign key fields. Drop Downs restrict the user to key values from the foreign file. They usually display descriptor fields to present the most readable information to the user. Drop down functions are identified by DD prefix and Function type D.

In effect, Flat Screen functions are used to display only a single record whereas Grid and List are used for multiple records. In an added complication, as a record can have many dependent records, Flat Screen functions will often have Lists or Grids attached.

These X-Browse Function Definitions are equivalent to Enhanced Screen Definitions, i.e. Screen Definitions which have been enhanced to cover a great deal of the built-in program logic as well. These Function Definitions are stored as table records on the AS400 (or similar server) and thus can be executed immediately once their design has been updated, with no re-compilation step.

The user with design authorities can perform function Designing in X-Browse. Screen Functions always start from a single main file, which is displayed in either Grid mode or Single Record mode. The screen function is constructed with fields from both this main file and all associated referenced files (in effect the owning files).  Initially the screen function generator only uses a single field from each referenced file which it has designated the most suitable descriptor field for that file. However, true multi-file programs are easily created through the Field and File Inclusion functionality described below.  The generation process has also specified all necessary cross file validation for the screen function together with links to any necessary drop down window functions.

The Function Designer provides for the following:

1. Changing the Layout of the function by reordering/adding/removing fields, Constant(s) text and color, field properties, etc. 

2. Manage Function Authorities viz. Allow Add/Update/Delete, Show/Allow Memos.

3. Inclusion of Foreign File(s)/Field(s).

4. Setting up Work Fields, e.g. Amount = Quantity * Price.

5. Integrating Business Rules i.e. the Shadow Program Exits.

6. Creating new Functions as Alternatives, deleting and rebuilding them.

7. Adding new actions and user exits.

8. Managing Dependents on a primary file.

The design process is described in two parts. First part deals with record function(flat screens) editing and the second is on grid function editing. 

Start X-Browse using Program Menu Shortcut provided by the X-Browse installation program. Start menu > Program menu > X-Browse > X-Browse Application. 

Having filled the entry dialog, click OK button.

Since the function name specified is ZACUSF, which is a Record type function, this brings up Record function for CUSF.

To bring the editor for the Record function, select the design [image: image79.png]


 button. 

Record function editor

The Record function editor comprises various design sections referred to as tabs here. We take up each tab as it appears while working in Design mode.

Drag and Drop tab XE " Record function editor:Drag and Drop tab" 
The Drag-n-Drop Tab is specific to Record screen designing only. It allows multiple Record Screen fields/constants to be repositioned as required. The following needs to be done:

1. Click the left mouse button on a field/constant to select it. The background changes to white implying selection. 

2. For multiple selections, press CTRL key and then click left mouse button on the required fields/constants. 

3. Bring the cursor onto the selected item and drag with the left mouse button pressed. 
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Release the mouse button where required.
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Field properties/attributes can be changed on the Field Properties Dialog. This is invoked by right clicking on the field and choosing Properties menu option. The Field Properties dialog here appears with Basic and Advanced tabs. Delete option on right-click menu deletes the constant/ field.

The field properties, which can be changed using field properties dialog, are discussed under Field Layout tab. 

The vertical and horizontal rulers indicate the row and column position of the field/constant.

A new constant can be added on the lower panel by entering the values for Row, Column and New Constant. Press Add button to see the constant on the screen above. The other buttons are Reset, Ok and Exit. Changes to the function specification get applied on pressing OK button.

Function Maintenance tab

The function maintenance tab provides the facility to define the authorities, options & control flags associated with the current function. There are a series of check boxes, which allow the user to customize the options for a function.
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The tab consists of the followings:

Title: The title of the function appears on the title bar of the display. The title is editable and if changed gets reflected for the current function only. This means that if the function appears as a dependent or an alternate function, then its dependent text or alternate function text remains unchanged irrespective of the change here.
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Default authorities XE " Record function editor:Function Maintenance tab:Default authorities" 
Allow Display: If the flag for the Grid function is checked, it enables the display button on toolbar [image: image81.jpg]


 and display option in the pop up menu as shown. This authorizes the user to display single record by selecting a row on grid and using the display button on the toolbar or display option on the popup menu.  

If the Allow display flag is not checked, both display button and the pop menu item are disabled.

For Record function it means that Record is not to be displayed.

Allow Update: This flag gives the authority to update the records on the flat screen. The drop list has two possible values.
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Allow update

It provides the authority to perform update on the single record. If update is allowed, the update button on the toolbar is enabled [image: image82.jpg]


. It also enables update option on the menu bar & pop up menu.
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2. Do not allow update


This means that user is not authorized to update a flat screen record. The update button on the toolbar is disabled [image: image83.jpg]


. Also, update menu option on the menu bar and in pop up menu are disabled.
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Allow Delete: The flag provides the authority to delete records. If checked, delete button on the tool bar [image: image84.jpg]


, the delete menu option on menu bar as well as popup menu are enabled.  

However, if the flag is not checked, delete button and the delete menu items are disabled.

The changes are visible only when the designer exits the design mode after saving the changes.
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Allow Add: The flag, if checked, gives the authority to add records. The Add button [image: image85.jpg]


 on toolbar, Add option on menu bar and popup menu are enabled thus allowing the user to add records. 

However, if the flag is not checked, the button and menu items are disabled.

Allow Memos: Enable Comments option. 

Control flags XE " Record function editor:Function Maintenance tab:Control flags" 
Starter Function: It is used to identify Grid type functions that show up on selecting Initial File option under the File menu on grid display.

Add On Grid: This flag is used in Thin-client mode. If checked, it allows the entry of records on the grid. (Available on Grid function design).

MS Word Interface: If checked, allows an interface to transfer comments to MS Word. This flag is of relevance to flat screen only. Two buttons are displayed on the comments panel for creating a word document by transferring a comment to MS Word and for viewing an already created document. These buttons are shown in the figure below encircled in red:
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MS Excel Interface: The flag controls whether user has the authority to transfer data to MS-Excel or not. If the flag is checked, it enables the excel button[image: image156.png]List of Non Primary Functions (x]
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 on the grid toolbar else it’s disabled.

If Use Lotus suite is checked on Configurator, it displays Lotus 1-2-3 option here. Grid toolbar then displays Lotus 1-2-3 icon.

Autogenerate PID: If checked, the values for a numeric primary identifier fields are auto generated else they are to be provided by the user.

Enabled only for a numeric PID.

Print: If checked, gives the authority to print the records on the grid.

View Memos: If checked, enables the comments option. 

Add on No Data: If checked, opens the function in Record's add mode if no data to display on Grid. 

Enable E-Commerce: If checked, brings up the E-commerce Design Tab.

The following are available on Grid design only:

1. Dependents to show as X-Web grid Actions: Specify the number. 

2. Pick the filter for the function: Pick filter for the function, if any.

3. Pick Function's Entry mode: Pick from Display, Add or Update modes. 

Shadow options have been taken up in the Program Design section.

Overriding Function Authorities XE " Record function editor:Function Maintenance tab:Overriding Function Authorities" 
Add/Display/Update/Delete/Print flags maintain the function level authority. These can be overridden for the function by a specific User profile. User Authorities button on the tab is used for this purpose.

XUSRAUT File holds User’s overriding authorities for each user profile and function. 

XUSRAUT table is referred in case function has one or more authorities suppressed. If user with a specific User Profile has an overriding authority for a function’s option, say Allow Add, then the Add option is enabled for that user.

The User Authorities button invokes a dialog where following authorities can be managed here:
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· Allow Display (ALWDSP): Authority to display Record.

· Allow Update (ALWUPD): Authority to update Record. 

· Allow Create (ALWCRT): Authority to add Record.

· Allow Deletion (ALWDEL): Authority to delete Record.

· Allow Print (ALWPRT): Authority to print Record.

· Allow Memos (ALWHYT): Authority to display memos.

The User Authorities are changed for the Function in use e.g. ZACUSF. The authorities changed or added for the different user profiles pertain to Function ZACUSF only.

The upper half of the window displays different user profiles with their present authorities for various functions. The lower half contains the authorities to be set for each function and user profile combination. The first record on the upper list is for adding a new entry with user set as NEWUSER.

Field Inclusion Tab

The Field Inclusion tab is used to determine the fields which appear on screen. The tab contains two lists – Visible Columns and Potential Columns. Former lists the fields that are currently being displayed. Latter lists the columns that can be added to the Visible Columns list.
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Visible fields XE " Record function editor:Field Inclusion Tab:Visible fields" 
List of all the fields included on the display. These include the fields from the primary file, foreign file and work fields.

1. The fields are shown as PHYSICAL FILE.FIELDNAME, e.g. CUSF.CNAME.

2. The work fields are prefixed with the text WORKFIELD and appear as WORKFIELD. Column Heading.[image: image158.png]Actions  Dependents [
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Potential fields XE " Record function editor:Field Inclusion Tab:Potential fields" 
Lists all the fields with their column headings not included on the display. The fields from the primary and foreign file e.g. descriptor or foreign field.

· A descriptor field has the syntax - FOREIGNFILE.FIELDNAME column heading (Description for <FLD1>), where FLD1 is the name of the primary file’s field for which FIELDNAME acts as the descriptor. E.g. CUSF.CSNAME Company (Descriptor for CUSNO).

· A foreign field has the syntax – FOREIGNFILE.FIELDNAME column heading (Related to <FLD1>), where FLD1 is the name of the primary file’s field that forms the link. E.g. CUSF.CUSNO Cus No. (Related to CUSNO).

The foreign fields would appear only for those files, which have been included in the Active secondary files list in the File Inclusion tab discussed latter.

Remove field XE " Record function editor:Field Inclusion Tab:Remove field" 
To remove a field(s) from the display, select relevant field from the Visible list and click the Remove button. Remove LCTDAT from the Visible columns.

The field now moves from the Visible to the Potential Columns. Note that although field LCTDAT has been removed from the visible area of screen the label Last Contact Date associated with it still remains. It has to be separately removed using the screen layout tab.  

Add field XE " Record function editor:Field Inclusion Tab:Add field" 
Designer can add potential fields to the display by selecting them from the Potential list and clicking the Add button. This updates the display showing the added field(s).

Key points:

1. Fields defined as keys or primary Identifiers (PIDS) cannot be removed.

2. Fields used in the calculation of a work field cannot be removed. To remove such fields, remove the work field first.

3. Fields having a descriptor cannot be removed.

4. Descriptor fields cannot be removed.

5. Field used as key field in any of the logical files cannot be removed.

6. Fields used in the E-commerce calculations cannot be removed.

7. When a work field is removed, it’s not added to the Potential list, instead is deleted from the function.

8. Session fields are not displayed in any of the lists. To add/remove session fields use the session field tab.

9. To select multiple fields keep the Ctrl (Control) key pressed and click the entry with left mouse button.
The fields which cannot be removed are shown in red.

If the display attribute of a field is set to Hidden, it’s present in the Visible fields but will not be displayed. On the Grid function editor the field appears as a column.

Field Layout tab XE " Record function editor:Field Layout tab" 
Field Layout tab provides an interface to change the way fields/constants appear and behave on the screen. All the active fields and constants are displayed in sorted order (in increasing order of row and column). The designer can reorganize the fields/constants, change the attributes like length, colour or decide what fields/constants appear on the screen.
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Before moving on to editing our example function ZACUSF, let us have a closer look at the contents of the Field layout tab.

Row & Column: Decide the position of respective field/constant on the screen.

Delete: Fields/Constants can be deleted by checking the delete checkbox. Those fields that cannot be deleted don’t have a delete checkbox.

Field Inclusion tab above specifies the fields which cannot be deleted.

Display length: The length of the field displayed on the screen. It can be more than the actual length of the field.

Field/Constant name: Field’s name is as per the database. Constant name is editable.

File: Filename to which the field belongs.

Shade: Presents a drop list of colours for changing the foreground colour of field/constant.

Edit codes: The edit codes are used to define the editing characters for a field and are displayed according to the field’s data type. A drop list shows the possible edit codes for the field. This list is based on the Data type of the field. For an alphanumeric field the possible data types are Y and L.

For a numeric field the edit codes are:

a) Edit codes for currency with grouping

1, 2, A, B, J, K, N, O

b) Edit codes for currency without grouping

3, 4, C, D, L, M, P, Q

c) For handling date types

Y

The default edit code is *.

Attribute: Field and Constant Attributes are different. 

· Field’s Attribute is shown as a drop list having values:

· Hidden

· Output

· Both (input/output)

Work fields & Session fields have the display attribute as Output i.e. read-only.

Fields with the attribute Hidden are present in the Visible Columns of the Field Inclusion tab but are not shown on the screen.
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Properties…: 

Other field attributes can be changed through Set field properties XE " Record function editor:Screen Layout tab :field properties"  Dialog.

The OK button on the properties dialog sets the attributes of the field but does not update them.  After setting the attributes of one or more field(s), designer needs to click on the OK button of the layout screen to save the changes.

Following field attributes can be set here:

Field name: Name of the field. 

File name: The name of the physical file to which the field belongs.
Key type: Identifies the type of key the present field is. It can be:

K
- Key field

F
- Foreign key

S
- Both, key and a foreign key

H
- High-level key

J
- High-level key & a foreign key

D
- Descriptor 

W
- Computed field (work field)

E
- Session field

*
- Default (Normal)

Field length: The actual length of the field. Designer can edit this value only when field type is W (work field).

Decimal position: The number of decimal positions for a numeric field. 

Data type: Holds the data type of the field viz. A / P / S / Z / B.

Date type: The drop list has values based on the edit code specified for the field.

If the edit code is ‘Y’ then the valid options are *6, *7, *8, *D, and **.

Currency symbols: This attribute of the field shows up only If the Currency edit code is specified for the field. The drop list with the currency symbols specified in the X-Browse configuration file is presented.

Date format: This field shows the possible date formats based on the length of the field. If no date Format has been specified, then it’s as per the table below:

	Date type
	Date Format

	*6
	YYMMDD

	*7
	CYYMMDD

	*8
	CCYYMMDD

	*D
	User defined

	**
	Default date format


Field processing: This field defines the word processing type for the field which will be used while transferring memos to MS-Word or sending them as e-mails. The valid values are:

	Field Type
	Usage
	Field Type
	Usage

	A1
	Address one
	PC
	Postal Code

	A2
	Address two
	SL
	Salutation

	A3
	Address three
	SN
	Surname

	A4
	Address four
	T1
	Text1

	ED
	Correspondence Date
	T2
	Text2

	CT
	Current Time
	T3
	Text3

	CY
	Country
	TL
	Subject Title

	EM
	Email
	UN
	User Name

	FN
	First Name
	WL
	Web Link

	JT
	Job Title
	NM 
	Full Name


Validation program: In this field the user can specify the routine name according to which that field must be validated whenever user adds/updates a record. It has the following pre-defined options: *PER, *TOT, *VARTOT, and *VARTOTG. Besides these, validation program name can also be specified.

Code field: Presents a drop list with N/Y/R as possible values. The default value is N.

· Setting it to Y implies that the field will be displayed as drop list with the values coming from XCODES file for that field.

· Selecting R means that the value should fall between a range of values. The lower and upper range values for a field are held in XRANGE file.

Blank not allowed: If this attribute is checked for a field, blank will not be allowed.

Yes No field: If checked, the field has only two possible values, YES or NO.

Check blank entries: If selected, then blank for an alphanumeric & zero for a numeric field is validated for:

· Code field attribute, if set to Y or R,

· Validation program specified, if any and

· Database integrity.

Work Field Formula: This attribute is set only if the field is a work field. The designer can update an existing work field formula here.

To understand the usage of the tab lets continue with the ZACUSF example.

The screen below shows that the flat record has been assigned row & column values which can be associated with the positioning of the field/constants. Position the cursor on the character C of the constant Cus No. and note the row and column values using the ruler provided. Using these values the constant (or a field) can be located in the layout tab.

Suppose the designer wants to reorganize the screen as follows:

· Extn. field should not appear.

· The constant Phone becomes Phone Nbr.
· Color of Cus No be different from other constants.

· Email should appear with its value shown in blue.
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To achieve the above organization of the ZACUSF function, designer has to perform the following tasks:

· Locate the constant Extn by its row and column and select its delete check box.

· Change the constant Name for Phone (row 2, column 65) to Phone Nbr.

· Locate the Cus No. constant (row 1, column 65) and change its shade to red.

· Locate Email constant and use the Shade drop list to change the color of the field to blue.

· Click OK button to save the changes.

The screen is refreshed using the modified function.
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The above screen shows:

· Cus. No. shows up in red.

· Constant Extn. has been removed.

· Phone No. is changes to Phone Nbr.

· Email field/constant field value shows up in blue

The fields and constants are associated only by their row and column positions respectively. This means that the designer can change the constant Address 1 and associate it with fields Address 1 to 4 if desired.

If a field is deleted, that does not imply its constant would also be deleted and vice versa. Designer needs to treat them and hence delete them, separately.

New Constants XE " Record function editor:Field Layout tab:New Constant" 
New constants can be added using the two add rows at the bottom of the tab.
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Set the row, column positions, name and shade for the new constant. The new constant(s) can also be set as an External constant. If the Is External checkbox is selected for a constant, it implies that the constant would be read from the file XECONSTS file. This allows designer to:

1. Declare constants of length greater than 50 characters and max. 1000 characters long.

2. Provide the language support i.e. if constants are required to appear in any other language.

As seen, this tab primarily deals with laying out the screen and changing properties of the fields/ constants.

Dependents tab

This tab displays the list of dependents for the present function. A dependent function equates to a child in the parent-child relationship of the data model, where the parent is the record being displayed in the RECORD function.

Refer X-Rev Technical Manual for the details of how this relationship is derived and how the data modeling decides if the child should appear in the dependents tab of a particular record function.
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This table contains the sequence number of the dependent, name of the dependent function with its Title, logical file name and text of the dependent function. Four other columns contain check boxes to facilitate: 

· Create Dependent using Alternate Key(s) 

· Making Writeable Function as dependent 

· Duplicating a dependent 

· Deleting a dependent 

Number of Dependents and Exits for a function cannot exceed 50. This tab shows the dependent functions only. The exits are shown in the Exits tab.

Reorganizing dependent function XE " Record function editor:Dependents tab:Reorganizing dependent function" 
The rows in the list are editable i.e. designer can pick dependent function, logical file and edit its sequence number. To edit any particular value, click on the cell to make it editable/selectable and update the value. Use OK button to save the changes.


The key points to remember while editing a dependent function are:

· The scope of the change in function text is limited to the current function only. 

· When a user deletes a dependent from the dependent list, it is added to the list of potential dependents

The button panel consists various buttons discussed below:

[image: image160.png]Add
Update
Update & Retun

Delete




Invoke Designer

Invokes Grid / Flat Screen designer for the function selected depending on the function type. 

Potential dependents XE " Record function editor:Dependents tab:Potential dependents" 
When a user deletes a dependent it is added to the list of potential dependents. This list can be invoked by clicking on the Potential Dependent button in the button panel. The list is shown as a table containing function name, text, logical file and check box (to enable addition / deletion).

Adding potential dependent

These potential dependents can be added back to the dependent list on the flat screen by marking the check box and clicking on Add button. The selected function(s) would be added to the table in the Dependents tab. If the number of potential dependents to be added increases the number of dependents to more than 50, an error message is generated in the status bar. 

[image: image161.png]Add
Upiete
Delete



Removing potential dependent

To delete a function from the potential dependents list, mark the function’s checkbox and click the Delete button. The function is removed permanently and cannot be added back to the list. 

If there are no potential dependents then a label No Potential Functions Found is displayed. 

Dependent On Alternate Key XE " Record function editor:Dependents tab:Dependent On Alternate Key" 
All the possible dependent functions for a parent are identified during the data modeling process. Function Designer gives the power of defining dependents based on a key structure that is different from the PID. Hence the term Dependent on Alternate key. 
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The Dependent on Alternate keys dialog consists of:

Function: The name of an existing list or Grid type function to be picked as dependent.

Function Text: Description for the new dependent.

Logical file: Name of the file to be accessed through the key structure.

Key structure: The different master keys will be determined by using alphabets A-Z. 

Available Fields is the list of fields from the parent file and Work fields. Designer can add fields from this list and define the master keys in the key structure. 

The sequence and attributes of the keys in the key structure should match with those of the file specified as logical file. Also the number of master keys should be less than the number of keys in the dependent logical file to generate data subset.

The dialog above shows a dependent, Customers by Representative being created on an alternate key CUSF.SINIT on Customers file’s logical by Representative/Customer holding the key structure as A. A field having attributes similar to SINIT must exist in the logical file picked and there should be at least one more key besides alternate key. Alternate key dependent is added successfully after these validations.

The other buttons on the tab are:

Reset: To reset the changes done by designer prior to saving them. 

OK: Save the changes made by designer.

Exit: Exit the design mode.

Actions tab

Screen functions are displayed in single record or grid mode. These functions are based on a single main file and consist of fields from this main file and all the referenced files. Designer has the choice of having more than one screen function based on a single file that provides a certain degree of customization.

Different functions can be used to perform various tasks. For example a certain function on a file can be used to display very limited information by hiding/removing certain fields. Another could be created to show only the relevant dependent function details of that file.

All the screen functions (or actions) based on the current file are listed under the Actions tab. The screen below shows one action, UACUSF (Sites) on file CUSF.
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Alternate functions list is shown as a table with following columns:

· Sequence: The sequence number of the alternate function for order of appearance.

· Action: The name of the alternate function with Title.
Delete: This column provides a check box to allow the user to select more than one function to delete from the table.

The rows of the table are editable which allows the user to pick an action. The sequence in which the action appears can also be changed using the sequence column. To achieve this the user needs to click on a column, update the values and click on the OK button to confirm the changes. However, a few key things need to be kept in mind while updating the function:

· The alternate function table can contain only the record type(ZAXXX) or update type function(UAXXX). 

· The primary functions (ZAXXX, UAXXX) can be swapped with an existing function. 

· The maximum number of alternate functions for any function is five. 

· At least one alternate function needs to be present in a grid function and a list function to enable the use of a Record screen display. 

The button panel has four buttons:

· Reset: To reset the changes before confirming them.

· Add Actions: Brings up Potential actions dialog with a list of Potential actions.

· OK: To confirm the changes.

· EXIT: Exit design mode.

Reorganizing Actions XE " Record function editor:Actions tab:Reorganizing Actions" 
The rows of the table are editable. The user can change the sequence of actions. The action can be picked from the drop-down.  To achieve this the user needs to click on the action row, update the values and click OK button to confirm the changes. 

X-Rev places ZAXXX as the primary Alternate function on the Grid/List/Record functions.
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Potential Actions XE " Record function editor:Actions tab:Potential alternate functions" 
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Potential actions dialog lists functions, which can be added as an action to the current function. The list is shown as a table containing the function name, function text and a column with a check box. The user can select and add more than one action to the current function. The dialog also displays the new possible Actions for the function, encircled in red. 

New Action XE " Record function editor:Actions tab:New alternate function" 
This dialog also allows the creation of a new action. Last two row of the dialog contain the names of new functions, which can be created and added to the current function. 
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To create a new function, mark the checkbox against the new function and click the OK button.

The text for the new function is shown as New Function for the File: <PHYSICAL FILE>. On creation the actual title of the file is shown. This function would come up only if there is a possibility of creating a new function & the maximum limit of alternate functions for the file is not reached.
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Thus Actions tab allows designer to customize the screen functions based on a single file. The various screen functions can then be used to perform dedicated tasks.

Exits tab

Exit routines are Custom programs which when called takes control and returns appropriate message on completion of the process laid out there. The programs can be on the local machine or on the server. The output from these routines is a message, like warning/validation message.
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When Exit routines are added they are shown in menu bar under the Actions menu as shown.

The button panel consists of the following buttons:

Add: Adds an exit routine

Update: Updates an exit routine
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Remove: Removes an exit routine

Exit: Exit design mode

Add Exit Routine XE " Record function editor:Exits tab:Add Exit Routine" 
To add a new exit routine, click on Add button. The following dialog prompts the designer to specify program name, caption and the hover text.

Update Exit Routine XE " Record function editor:Exits tab:Update Exit Routine" 
To update an exit routine, select the routine and click on the Update button. A dialog appears with the values for that routine which can be altered by the designer. Click on the OK button to confirm the changes.

Remove Exit Routine XE " Record function editor:Exits tab:Remove Exit Routine"  

To remove an exit routine, select the routine and click the Remove button.

The User Exits resides on the server and are called by the Shadow program specified for the function (XFUNDEF.SHWPGM) via the XEXIT server program. Existence of the routine is not checked and it’s the responsibility of the designer to programmatically check its existence in ZEPROG sub-routine of Shadow program.

ENTRYPOINT Parameter of the shadow program is the Exit Routine name and ACTION=CALL.

Work Fields tab

Work Fields are fields whose values are generated by an expression or a formula relating to the existing field values of the current function. e.g. Value = Price * Number of Units, where Value is work field and Price and Number of Units are the fields of the physical file. This facility allows the user to define new fields without changing the existing format of the file. 

Adding a Work field XE " Record function editor:Work Fields tab:Adding a Work field" 
To add a work field, designer needs to provide the following entries:

Field name: Name of a work field. It should start with an alphabet.

Field type: Field type is A for alphanumeric field, and S for Signed Numeric field.

Field length: Field length can be a maximum 30 long for Signed numeric fields and 50 long for alphanumeric fields.

Decimal position: Blank for alphanumeric field. 0 - 9 for Signed Numeric field.

Field text: 20 characters of field text. If more are needed, add on the design window.

Work field formula: The work field formula can be maximum 100 characters. Enter a relevant expression/formula using the fields in Visible Columns of Field Inclusion tab. The formula can be constituted using the fields and operators lists provided. Double-clicking on the entries on the lists puts the field/operator in the Work field formula. The formula is validated when OK button is pressed. 

The following operators are used for numeric and string operations in the work field formula:

· Addition +
· Subtraction -
· Division /
· Multiplication *
· Braces ( and )
BODMAS rule is followed while calculating the value of a numeric field.

· Concatenation !! - Used for String concatenation

· Equal To = - Used to assign a value to another field

· DIGIT - Used to extract the numbers from an alphanumeric field. The digits are in the same order they appear in the field.

· SUBSTR - Used for Substring operations. The syntax is SUBSTR (<field name>,  <start pos>,  <number of characters>)

The screen below shows a work field Contact Person being added to the screen. The formula specified is: CUSF.ADD1 !! ‘ ‘ !! CUSF.ADD2 !! ‘ ‘ !! CUSF.ADD3
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The adjacent screen shows the data for the fields ADD1, ADD2 & ADD3 for a record concatenated together for a new field Contact Address.
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Examples using numeric data: 
· 2 * 5 + 1, result is 11.

· 2 * (5 + 1), result is 12.

· QTY * PRICE * ((VAT + 100) / 100).

Operators XE " Record function editor:Work Fields tab:Operators" 
· DIGIT(<FIELDNAME>) filters the digits from an alphanumeric string and places them in a numeric workfield. E.g. if the field with text After 3 days, add 15% to the price is acted upon by DIGIT operator, the work field will contain 315.

· SUBSTR(field, StrPos, Length) extracts a sub-string out of field’s value.

· !! Performs string concatenation. If the field CUSF.CSNAME = Databorough Ltd, the expression  ‘Company: ' !! SUBSTR (CSNAME, 1, 11) evaluates to Company: Databorough.

· CALL PgmNam:- for future use

· =(Equal To) The equal to operator is used to assign a value to the field in the current file on the basis of an expression. 

Key points

· !!(Concatenation of strings): It is used to concatenate two or more fields of data type = A or concatenate String constants.

· +,-,*,/, DIGIT() will be performed if the work field type is numeric. However if the formula performs nested operations, the field type is ignored and the return type value for such an operation should be numeric only.

· SUBSTR will be performed if the work field type is alphanumeric. However if the formula performs nested operations, the formula type is ignored. The return type value for such an operation should be string only.

Sample Formulas:

1. FLD1 !! FLD2

Concatenates the FLD1 with FLD2

2. FLD1 !! SUBSTR(FLD2, 1, 5)

Sub-strings the FLD2 from starting at 1 till he next 5 characters. The FLD1 concatenates with the SUBSTR’s result.

3. FLD1 !! SUBSTR(FLD2, DIGIT(FLD3), 5)

Performs the digit operation on FLD3. The digits will be used as the starting position while performing the sub-string on FLD2. The FLD1 concatenates with the sub-string result.

4. SUBSTR(FLD1 !! FLD2, 1, 5)

FLD1 concatenates with FLD2. The sub string is performed on the result from starting position 1 till next 5 characters.

5. FLD1 * FLD2 + DIGIT(FLD3 !! FLD4)

In the first operation, FLD3 concatenates with FLD4. The digits are taken out from this result and are added to the result of the multiplication of FLD1 and FLD2. 

6. 
FLD1 = FLD2 + FLD3

FLD# are the fields from the field List and the sum of FLD2 & FLD3 is placed in FLD1.

File Inclusion tab

As the dependents tab displays the child type relationships in the data model, File inclusion tab is a list of those database entities that could be considered parents to this record.
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Active secondary files XE " Record function editor:File Inclusion tab:Active secondary files" 
Lists all files which have a refers-to relationship (foreign field of the current file refers to primary key of secondary file) with the primary file, and are included in the current function. 

Potential secondary files XE " Record function editor:File Inclusion tab:Potential secondary files" 
Lists files which have a refers-to relationship (foreign field of the current file refers to primary key of secondary file) with the primary file, and are NOT included in the current function.

All secondary FILE (FIELDS) involved in the relationship (Foreign Keys) are shown (Comma separated, if more than one).

Add File XE " Record function editor:File Inclusion tab:Add File" 
This button is used to add files from Potential Secondary Files list to Active Secondary Files list. Select file(s) from potential list and press Add button. To add a field (foreign fields like descriptor field, etc.) from the file to the current function, use the Field Inclusion tab discussed above.

Remove File XE " Record function editor:File Inclusion tab:Remove File" 
This button is used to move files from Active Secondary Files list to Potential Secondary Files list. Select file(s) from active list and press the Remove button. When a secondary file is removed, the fields of this file also get removed from the function.

Grid function editor XE "Grid function’s other tabs" \t "See Record Function editor" 
The following tabs are the same as in Record Function Editor:

· Dependent Tab

· Actions Tab

· Exits Tab

· Function Maintenance Tab

· Field Inclusion Tab

· File Inclusion Tab

· Work Fields Tab

The tabs specific to Grid Function Editor are discussed below.

Field Layout tab XE " Grid function editor:Screen Layout tab" 
The Field Layout tab allows the user to update the attributes of the fields occurring in the grid display. This tab shows the list of fields which are present in the visible columns list of the Field Inclusion tab. Each field appears as a single panel with its attributes. 
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Following attributes can be set:

Seq.: This relates to the sequence of the field in the physical file. A point to remember is that the data being displayed is based on the logical file, whereas the tabs of the designer are based on the physical file. This would bring up the fields in the grid definition in a sequence different from the one appearing in the grid data table. The sequence number is shown in a text box and can be updated by the user. Keys of the logical file will always appear on the left, irrespective of the sequence.

Field: The name of the FILE.FIELD is shown in the form of a label.

Column heading: The field’s column heading is 50 characters long. This is updateable and the user needs to click on the OK button to confirm the changes to the specifications.

Display length: This is the length of the field that is displayed on the screen. It can be more than the actual length of the field.

Edit code:  Same as for Record function.
Attribute: Same as for Record function.
Properties…: Same as for Record function. The only difference is the field Type.

· Field type: For a numeric field the valid values are:

TT – field is a totals field

Delete: The fields/constants can be deleted by checking the delete checkbox. Note that every field does not have a delete checkbox. Refer Field Inclusion tab for more details.

Logical Views tab XE " Grid function editor:Logical Views tab" 
Logical Views tab displays a list of active logical files for the current screen. The logical files present here appear in the LookupBy menu providing option to have different views of the data for a physical file.

The table has five columns: Seq., Title, File, Keys & Delete.

· The Seq. and Title are editable.

· The views can be re-sequenced.

· File and Keys are read-only.

Four buttons on the Tab are: Reset, Add Logical views..., OK, Exit. Click OK button to save the changes. 
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The Keys column holds key(s) of the logical file (comma-separated if more than one). They become the left most columns when grids are displayed. 
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The logical views can be removed for the function by using Delete checkbox. Designer needs to mark the delete checkbox for the view(s) and click OK. The removed views are added to the Potential Logical Views list. 

To list the Potential Logical Views, if any, click on the Add Logical Views button.

To add potential logical view to the function, check Status checkbox and press Add. 

Cancel button returns to the logical views screen. 

List function editor XE "List function editor" \t "See Record function editor" 
List Functions can be managed exactly the same way as Record Functions. Here the E-commerce and Logical Views Tabs are the same as in Grid Function Editor.

Work with Function

Besides maintaining function, the Design menu has host of other options to be applied on the function in use. 
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Select Function XE " Work with Function: Select Function " 
On choosing the Select function option under the Design Menu, a dialog box is displayed as shown.

The dialog lists a number of alternate functions. Select one of the function and click on select button. This opens the selected function in Design mode.
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Delete Function XE " Work with Function: Delete Function " 
Delete function option under the Design Menu presents a list of Non-primary functions on the Physical file in use. Selection of the function(s) enables the Delete button. Click it to delete the function(s) checked.

Rename Function XE " Work with Function: Rename Function " 
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Rename Grid Function

Select the Rename Grid Function option from the Design Menu in the Grid Display Mode. This brings up a dialog to rename the grid function as shown

Give a new name and title values and click on the ok button.

Rename Record Function

Select the Rename Record Function option from the Design Menu in the Record Display Mode to rename the Record function.
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Create New Function XE " Work with Function: Create New Function " 
New Grid Function

Select the New Grid Function option of the Design Menu in the Grid Display Mode

This brings up a dialog as shown. Specify the Function Name, Function Text, and the Function Action Details in the provided textboxes and click Ok.
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New Record Function

Select the New Grid Function option of the Design Menu in the Record Display Mode

This brings up a dialog as shown. 

Specify the Function Name, Function Text in the provided textboxes and click Ok.

Rebuild/Reformat Function XE " Work with Function: Rebuild/Reformat Function " 
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Rebuild Function

Select the Rebuild function from the Design menu in Grid / Record Display. This option displays a dialog box as shown. Enter the maximum number of grid/record fields for the Grid/Record Display function and then click Ok.
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Reformat Function

This is available on Record function only. Select the Reformat function option of the Design menu in Record Display Mode. This brings up a dialog box as shown. This Dialog box is used to rearrange the fields on the Record Display Mode.

Variable Field Label
Field labels on Record display and Column headings on the Dependent grids can be made a variable entity by specifying special pattern. The data held in database for the <File>.<Field> combination specified after the special pattern is substituted for the dependent grid column heading or record display.

The format for specifying the variable column heading is /*\<FILE>.<FIELD>


The pattern can be applied on the dependents at any level on a grid as well as on a record. An example follows:

· Open the grid display for Stock Group 2 (AASTKGRP2).

· Click on the Stock Group 3 option under Dependents menu for the Description – FICTION.

· Select design mode on the grid display for Stock Group 3
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In the Field Layout tab, replace the Column Heading for Desc with the value /*\STKGRP2.XWIWTX and click Ok to save changes.
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The column heading for the Desc column would now be replaced with the value of STKGRP2.XWIWTX, which is FICTION.
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The same pattern can be applied to flat record display of Stock Group 3 records.

Double click on the first record in the grid display to go to the flat record display.

Enter design mode.
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In the field layout tab, specify the pattern /*\STKGRP2.XWIWTX in place of Desc.

Click OK.
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The label Desc on the flat panel display would now be replaced with FICTION.
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Program Design

When using a GUI application (either a client/server application or a web-based application), there are certain identifiable points in the processing cycle. These are: 

1. Before the data is displayed.

2. When any input data is to be validated

3. Before the data is updated

4. After the data is updated

5. Exiting the screen.

When either X-Web or X-Browse reaches these points in the processing cycle, the screen function is checked to see if any action is to be taken. The shadow exit program “shadows” the screen processing and is called to perform the actions required. These programs reside on the server and are normally written in RPG or RPGLE.

A standard string of parameters together with the screen data is passes to the shadow exit program. The shadow exit program in turn returns updated data and other values including error messages to XWEB/XBROWSE.

Shadow exit program

This program is automatically generated by the command XBWRTSHD. The program generated is a “shell” providing points for the developer to add the appropriate code. The program can be generated in either RGP or RPGLE depending on the system requirements.

Configuring entry points XE "Shadow exit program:Configuring entry points" 
The following need to be set for a function on the Function Maintenance tab for desired behavior:

Shadow Pre-Entry: If the flag is checked, the control is transferred to the shadow program before entering into the record display. The program can be made to perform certain checks, validations and take decision based on them. This can also be programmed to return a different Function to call, e.g. on the basis of Customer Type in the current record, having less number of fields.

Shadow Pre-Display:  If the flag is checked, the control is transferred to the shadow program before displaying the data on the screen. The shadow program should contain a pre-display routine to perform a set of operations on the data yet to be displayed. The program is called irrespective of the action i.e. add, update, delete or display. The shadow program returns modified data, which is then displayed.

Shadow Validation: The shadow validation flag, if checked, transfers the control to the validation routine of the shadow program. This routine is called whenever add, update or delete is performed. It performs a set of validations on the current record and generates messages based on the validations.

Shadow Pre-Update: If checked, the pre-update routine in the shadow program is called before performing the actual update in the database. It is called whenever add, update or delete takes place. The shadow program would perform a set of operations on the data that is to be updated and returns the modified data for the actual update.

The shadow validation and pre-update routines can also be programmed to return an alternate function to use in NEWFUN parameter, to facilitate cascaded add/update requirement taken up later. 

Shadow Post-Update: The shadow post-update flag, if checked, transfers the control to the post update routine of the shadow program. This would be done after the data has been updated in the database i.e. after add, update or delete action has been performed. 

Shadow On Exit: The shadow on-exit flag, if checked, transfers the control to the on-exit routine of the shadow program. This facilitates invoking of another function when exiting out of the current function by passing a new function name in NEWFUN parameter.

Shadow Program: Shadow Program is a user written program to which the control is transferred for executing validation checks, data modifications, etc. The program’s object should be in one of the library of the X-Browse / X-Web library list.

The above mentioned entry points for a function can be enabled or disabled with the help of checkboxes provided on the Function Maintenance tab. 

	Shadow Program Field
	Type
	Purpose…
	Value

	SHWPGM
	20A
	Shadow Program Name
	e.g. ZACUSF

	SHWPEN
	1A
	Shadow Pre-Entry
	Y/N

	SHWDSP
	1A
	Shadow Pre-Display
	Y/N

	SHWVAL
	1A
	Shadow Validation
	Y/N

	SHWBUP
	1A
	Shadow Pre-Update
	Y/N

	SHWAUP
	1A
	Shadow Post-Update
	Y/N

	SHWEXT
	1A
	Shadow on Exit
	Y/N


Messages generated XE "Shadow exit program:Shadow program Messages" 
All the shadow options generate a set of messages of the following types:

1. Warning: On warning, X-Browse presents an option dialog and the user needs to take a decision whether to proceed or cancel. On X-Web, setting the Ignore Shadow warnings to true for a site ignores the warning messages altogether. If it is set to false, the user is presented record(s) with warning, which can be ignored to proceed. However, Add on Grid with more than two add rows, if has a row in error and warning, the user needs to ignore it by checking the OK checkbox against row with a warning.

2. Error: The shadow program returns an error message or a set of error messages. They are displayed in red on the screen where the action was performed. The fields in error are highlighted.

3. Change: Only the shadow pre-entry flag generates it. This signifies that there is a change in function to be used for displaying the screen.

4. Information: All the information messages generated by the shadow program while performing an action are collected and displayed once the control returns from shadow program.

Shadow program

The skeleton for the shadow program is automatically generated by the command XBWRTSHD (XREV library should be in the library list before running this command). The program generated is a shell providing points for the developer to add the appropriate code. The program can be generated in either RPG or RPGLE depending on the system requirements.

                   Write Shadow Program Template (XBWRTSHD)  

Type choices, press Enter.                                   

Function Name  . . . . . . . . . > ZACUSTS                    

X-Browse Function Library  . . . > XAN4CDXT      Name        

Source File  . . . . . . . . . . > QRPGSRC       Name        

Source Library . . . . . . . . . > XAN4CDEM      Name        

Source Type  . . . . . . . . . .   RPG           RPG, RPGLE  

Only write out primary file  . . > *YES          *YES, *NO                                                         

Following is an extract from a RPG shadow program shell produced by XBWRTSHD command. The text in grey background indicates the subroutine executed for entry point PREUPDATE.

 ...

 I* Named Constants                                                         

 I              'PREDISPLAY'          C         LPREDS                      

 I              'VALIDATION'          C         LVALID                      

 I              'PREUPDATE'           C         LPREUD                      

 I              'POSTUPDATE'          C         LPOSUD                      

 I              'PREENTRY'            C         LPREEN                      

 I*                                                                         

 C**********************************************************************    

 C* M a i n l i n e   C o d e                                               

 C**********************************************************************    

 C* Format file records                                                     

 C           001       OCUR INDBFS                                          

 C                     MOVELINDBFS    FILE1                                

 C*                                                                         

 C* Process individual entry points etc                                     

 C                     SELEC                                         

 C*                                                                  

 C* PREDISPLAY                                                       

 C           EPOINT    WHEQ LPREDS                                   

 C                     EXSR ZPREDS                                   

 C* VALIDATION                                                       

 C           EPOINT    WHEQ LVALID                                   

 C                     EXSR ZVALID                                   

 C* PREUPDATE                                                        

 C           EPOINT    WHEQ LPREUD                                   

 C                     EXSR ZPREUD                                   

 C* POSTUPDATE                                                       

 C           EPOINT    WHEQ LPOSUD                                   

 C                     EXSR ZPOSUD                                   

 C* PREENTRY                                                         

 C           EPOINT    WHEQ LPREEN                                   

 C                     EXSR ZPREEN                                   

 C* CALL TO EXIT PROGRAM                                             

 C           ACTION    WHEQ 'CALL'                                   

 C                     EXSR ZEPROG                                   

 C*                                                                     

 C                     ENDSL                                            

 C*                                                                     

 C* Update buffers if necessary                                         

 C           RTUBUF    IFEQ 'Y'                                         

 C           001       OCUR INDBFS                                      

 C                     MOVELBCMTRP    INDBFS                            

 C                     ENDIF                                            

 C*                                                                    

 C* Perform Termination Routines                                        

 C                     MOVEL*ON       *INLR                             

 C                     RETRN                                            

 ...

Parameters required XE "Shadow exit program:Parameters required" 
Following parameters are to be passed to the shadow program.

	1.
	INUSER
	10
	User name

	2.
	INDATE
	8
	Date

	3.
	INTIME
	6
	Time

	4.
	ACTION
	10  
	Indicates the action performed - ADD, UPDATE, DELETE, DISPLAY

	5.
	EPOINT
	20
	This parameter is set according to the type of call from XWEB/XBROWSE

· PREENTRY

· PREUPDATE

· VALIDATION

· POSTUPDATE

· PREDISPLAY

	6.
	INDBFS
	21 x 3000
	21 X 3000 bytes of data representing a single record for each of the primary physical files & up to 20 secondary files.

	7.
	RTMSGT (output)                                                                             


	1
	Return message type – used for validation and the pre-entry switch

· I - information

· E - error

· W – warning

· C - Function name changed

· Blank – no error/action

	8.
	RTM (output)
	20 x 80
	Array for return messages 

	9.
	RTI (output)
	20 x 7
	Array for return messages ID’s

	10.
	RTF (output)
	20 x 10
	Array for the fields to which messages relate 

	11.
	RTUBUF  (output)
	1
	Flag to indicate if fields have been updated 

	12.
	NEWFUN  (output)
	20    
	New function name for PREENTRY processing 

	13.
	GTOT         
	30 – 9 dec places
	Total for total processing

	14.
	ZWF (output)
	20 x 50
	Work field values.

	15.
	ZWN (output)
	20 x 30
	Work field names.

	16.
	ZWT (output)
	20 x 1
	Work field data types.

	17.
	SPF (output)
	20 x 30
	Array of fields to be suppressed

	18.
	CNF (output)
	20 x 30
	Array of fields to be shown as constant

	19.
	CLF (output)
	20 x 30
	Array of fields whose colour is changed.

	20.
	OVC (output)
	20 x 3
	Array of colours to override


Building code XE "Shadow exit program:Building code" 
The code is added to the supplied stubs in the shadow program. It gets executed only if the appropriate shadow flag is set. 

The following is where the code for each of the required exit points is inserted.

The precise nature of the exit point can be determined by the “ACTION” parameter:



ADD



UPDATE



DELETE



DISPLAY

C**********************************************************************  

C* PREDISPLAY Routines                                                   

C**********************************************************************  

C           ZPREDS    BEGSR  

Code can be inserted here – pre-entry display – can be used to populate a record for display or to calculate fields.                                            

C                     ENDSR                                              

C**********************************************************************  

C* VALIDATION Routines                                                   

C**********************************************************************  

C           ZVALID    BEGSR                                              

Code can be inserted here  - this is the validation routine – can return the following:

Error flag – RTMSGT = blank (no error), W (Warning), E (Error)

Error messages – up to 20 error messages can be returned in array RTM (80 characters per message)

Field names – up to 20 in array RTF

RTI – Up to 20 messages ID’s can be returned in this array                                         
The subroutine can be made to return NEWFUN with function to call to facilitate requirements like cascaded Add/Update as in the example source lines below
C           STATUS    IFEQ 'A'

C                     MOVEL'ZBCUSF'  NEWFUN                                

C                     MOVE 'Y'       RTUBUF 

C                     ELSE                               

C                     MOVEL'ZCCUSF'  NEWFUN                                

C                     MOVE 'Y'       RTUBUF 

C                     ENDIF

OR the subroutine can be made to validate fields on Add/Update as in the example source lines below
C           XWGIVA    SUB  XWIDV0    XDIFF  152

C           XDIFF     IFLT *ZERO

C                     MOVEL'E'       RTMSGT

C                     MOVELEM,1      RTM,1

C                     MOVEL'XWGIVA'  RTF,1

C                     ENDIF

C                     ENDSR                                              

C**********************************************************************  

C* PREUPDATE Routines                                                    

C**********************************************************************  

C           ZPREUD    BEGSR                                              

Code can be inserted here – called before a record is updated. Examples of use may include calculating or initializing fields not on the screen display                                            
The subroutine can also be made to return NEWFUN with function to call to facilitate requirements like cascaded Add/Update as in the example source lines below
C                     MOVEL'ZBCUSF'  NEWFUN                                

C                     MOVE 'Y'       RTUBUF                                

C                     ENDSR                                              

C**********************************************************************  

C* POSTUPDATE Routines                                                   

C**********************************************************************  

C           ZPOSUD    BEGSR                                              

Code can be inserted here – called when action is required after a record has been updated                                           
C                     ENDSR                                              

C**********************************************************************  

C* PREENTRY Routines                                                     

C**********************************************************************  

C           ZPREEN    BEGSR                                              

Code can be inserted here – this is the function switch exit – this can be used to determine which function to be displayed for an account type or transaction type.

New function name is placed in NEWFUN and RTMSGT is set to ‘C’                                            
C                     MOVEL'ZCCUSF'  NEWFUN                                

C                     MOVE 'C'       RTMSGT                                

C                     ENDSR                                              

C**********************************************************************  

C* CALL TO EXIT PROGRAM                                                  

C**********************************************************************  

C           ZEPROG    BEGSR       

C           EPOINT    IFEQ ‘CLETN’

C                     CALL ‘CLETN’                                       

Code can be inserted here                                            

C                     ENDIF       C                     ENDSR                                              

Sample shadow program XE "Shadow exit program:Sample" 
Let us have a closer look at the ZACUSTS shadow program. The code with grey background is the Validation code that is executed on add/update.

     H*¹--------------------------------------------------------------------

     H*ÌCOPYRIGHT DATABOROUGH LTD 2000

     H*Ì

     H*ÌPROGRAM:  Shadow Program for ZACUSTS

     H*ÌAUTHOR:   Databorough Ltd.

     H*ÌVERSION:  No:   1.00    Date: 24/07/2001

     H*¹--------------------------------------------------------------------

     H        1

     E**********************************************************************

     E*¹D e f i n i t i o n s

     E***************************************************************** 

     E                    RTM        20 80                         

     E                    RTI        20  7                         

     E                    RTF        20 10                         

     E                    ZWF        20 50                         

     E                    ZWN        20 30                         

     E                    ZWT        20  1                         

     E                    SPF        20 30                         

     E                    CNF        20 30                         

     E                    CLF        20 30                         

     E                    OVC        20  3                         

     E                    EM      1  01 80                         

     E*

     IINDBFS      DS                         213000

     I*

     I*¹Format file data

     I*

     I*¹FILE NAME

     ICUSTS     E DSCUSTS

     I*

     I*¹Named Constants

     I              'PREDISPLAY'          C         LPREDS

     I              'VALIDATION'          C         LVALID

     I              'PREUPDATE'           C         LPREUD

     I              'POSTUPDATE'          C         LPOSUD

     I              'PREENTRY'            C         LPREEN

     I              'ONEXIT'              C         LONEXI

     I*

     C**********************************************************************

     C*¹M a i n l i n e   C o d e

     C**********************************************************************

     C*¹Format file records

     C           001       OCUR INDBFS

     C                     MOVELINDBFS    CUSTS

     C*

     C*¹Process individual entry points etc

     C                     SELEC

     C*

     C*¹PREDISPLAY

     C           EPOINT    WHEQ LPREDS

     C                     EXSR ZPREDS

     C*¹VALIDATION

     C           EPOINT    WHEQ LVALID

     C                     EXSR ZVALID

     C*¹PREUPDATE

     C           EPOINT    WHEQ LPREUD

     C                     EXSR ZPREUD

     C*¹POSTUPDATE

     C           EPOINT    WHEQ LPOSUD

     C                     EXSR ZPOSUD

     C*¹PREENTRY

     C           EPOINT    WHEQ LPREEN

     C                     EXSR ZPREEN

     C* ONEXIT

     C           EPOINT    WHEQ LONEXI

     C                     EXSR ZONEXI

     C*¹CALL TO EXIT PROGRAM

     C           ACTION    WHEQ 'CALL'

     C                     EXSR ZEPROG

     C*

     C                     ENDSL

     C*

     C*¹Update buffers if necessary

     C           RTUBUF    IFEQ 'Y'

     C           001       OCUR INDBFS

     C                     MOVELCUSTS     INDBFS

     C                     ENDIF

     C*

     C*¹Perform Termination Routines

     C                     MOVEL*ON       *INLR

     C                     RETRN

     C**********************************************************************

     C*¹L o g i c a l   E n d   o f   P r o g r a m

     C**********************************************************************

     C*

     C**********************************************************************

     C*¹PREDISPLAY Routines

     C**********************************************************************

     C           ZPREDS    BEGSR

     C                     ENDSR

     C**********************************************************************

     C*

     C**********************************************************************

     C*¹VALIDATION Routines

     C**********************************************************************

     C           ZVALID    BEGSR

     C           XWGIVA    SUB  XWIDV0    XDIFF  152

     C           XDIFF     IFLT *ZERO

     C                     MOVEL'E'       RTMSGT

     C                     MOVELEM,1      RTM,1

     C                     MOVEL'XWGIVA'  RTF,1

     C                     ENDIF

     C                     ENDSR

     C**********************************************************************

     C*

     C**********************************************************************

     C*¹PREUPDATE Routines

     C**********************************************************************

     C           ZPREUD    BEGSR

     C                     ENDSR

     C**********************************************************************

     C*

     C**********************************************************************

     C*¹POSTUPDATE Routines

     C**********************************************************************

     C           ZPOSUD    BEGSR

     C                     ENDSR

     C**********************************************************************

     C*

     C**********************************************************************

     C*¹PREENTRY Routines

     C**********************************************************************

     C           ZPREEN    BEGSR

     C                     ENDSR

     C**********************************************************************

     C*

     C**********************************************************************

     C*¹ONEXIT Routines

     C**********************************************************************

     C           ZONEXI    BEGSR

     C                     MOVEL'ZBCUSTS' NEWFUN

     C                     ENDSR

     C**********************************************************************

     C*¹CALL TO EXIT PROGRAM

     C**********************************************************************

     C           ZEPROG    BEGSR

     C                     ENDSR

     C**********************************************************************

     C*¹N o n - e x e c u t a b l e   C o d e

     C**********************************************************************

     C           *ENTRY    PLIST

     C                     PARM           INUSER 10

     C                     PARM           INDATE  8

     C                     PARM           INTIME  6

     C                     PARM           ACTION 10

     C                     PARM           EPOINT 20

     C*¹21 X 3000 bytes of data representing a single record for each of the

     C*¹primary physical file & upto 20 secondary files

     C                     PARM           INDBFS

     D*¹Return message type

     C                     PARM           RTMSGT  1

     C*¹Array for return messages

     C                     PARM           RTM

     C*¹Array for return message iDs

     C                     PARM           RTI

     C*¹Array for the fields to which messages relate

     C                     PARM           RTF

     C*¹Flag to indicate if fields have been updated

     C                     PARM           RTUBUF  1

     C*¹New function name for PREENTRY processing

     C                     PARM           NEWFUN 20

     C*¹Further fields

     C                     PARM           GTOTS  309

     C                     PARM           ZWF

     C                     PARM           ZWN

     C                     PARM           ZWT

     C**********************************************************************

**

MSG01  Balance Exceeds Credit Limit.

Thin Client Designer

X-Browse, besides function design and maintenance, allows user to configure and maintain certain X-Web features like

· Menus using Menu Manager

· Job scheduling through Job Scheduler

· Blobs and images using Blob Manager

· User Profile and Member information via User Profile Manager

Menu Designer XE "Thin Client Designer:Menu Designer" 
Each function has a menu attached to it referred to as Function Menu. This appears on each X-Web page when that function's page is gets rendered. Besides this the non-function Menus, e.g. BARCTL – Generic Control Bar,  are also managed here. Menu Manager allows the designer to maintain the various menu options for the function.
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Seq: The sequence of the Menu option. The options can be re-sequenced.

Action: The action for the Menu option. They are.

· Function 

· Record 

· Report 

· Full Report (Available on Record Screen and Non-function menu design) 

· Graph 

· Full Graph (Available on Record Screen and Non-function menu design) 

· Other 

Type: The type of Menu option.

When Action picked is Report / Full Report the types available are:

	· Details
	· Totals and %
	· Complete Records
	· Totals 


For Graph / Full Graph Action Type the types are:

	· Bar
	· Line
	· Pie
	· Histogram


For Other Action Type the types are:

	· Menu Heading
	· Command
	· Link
	· User Info

	· Date
	· Anchor
	· Text Page
	· 


Function: The function is presented as a dropdown populated with Grid or Record functions depending on whether the menu action is a Function or Record. If the Action is Other and the Type picked is Command, the Function dropdown shows the following command list:

· *DESIGN - Page Layout menu option 

· *SITEADMIN - Site Administration menu option 

· *PWS - Personal Web Space menu option 

· *XDIARY - Personal Diary menu option 

· *HELP - Help menu option 

· *HELPTOG - Help toggle menu option 

· *LOGOUT - Logout menu option 

Logical File: The Logical file shown depends on the Function picked. This is valid for the Function, Graph and Report Action types only.

Date Totaling: This is valid for Report and Graph Action type only and is shown if the function/logical file selected has a date field. The possible values are:

	· Yearly
	· Monthly
	· Quarterly
	· Weekly
	· Daily


Besides the above, for the Report Action type, the Report Intervals are also listed, if any. 

Caption: The caption of the menu option can be altered here. The caption appears as link on the X-Web page. For Action-Other and Type-Date, Caption contains certain predefined Date formats.

Delete: This allows deleting the selected menu option from the menu being designed.

Add to all: If checked, the selected menu option is added to all the function menus not having this menu option.

Delete from all: If checked, the selected menu option is deleted from all the function menus having this menu option.

Add Menu Option

Add Menu option brings up a dialog to add a new menu option. 
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The options are self-explanatory here. Depending on the Action chosen, on OK, the relevant properties dialog is invoked.

Function Properties Dialog - When Action picked is Function or Record
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· Report Properties Dialog - When Action picked is Report or Full Report
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Here the Report menu options can be configured for generating specific reports. When adding Report menu option for a menu on record function, Add menu option dialog lists only dependent functions in Function drop-down. This means that only those records are reported which the record on display owns. If Full-Report menu option is picked, all the grid functions are listed in the Function drop-down. Record menu option on Grid Menus lists all the functions.

Dependent Function, LF & Filter are explicitly defined. In 99% of reports only one dependent function will be used, but the design allows for up to 3 dependent functions. Each has a subtotal flag for sub-totaling. This is only relevant to the case of a totaled report with one or more dependents (e.g. date totaling of order headers with dependent function of order lines). In this case if subtotaling is unchecked then the keys of the dependent are ignored and the dependent records simply totaled for each parent record. However if subtotaling is checked then totals will also be produced for EVERY break of key on the dependent.

Show descriptors has the following values:

· N=No

· Y=Show if within grid function

· A=Show if obtainable from record function

Ignore Null breaks, if checked, suppresses Total Breaks with no total data.

· Graph Properties Dialog - When Action picked is Graph

[image: image112.png]Field Setings
Fil LogicalFie

Fiter D Select Calculationtype  [Total

Field on YA [Quanity s FeldLabel  [Quertily

Field on X Asis Xis FieldLabel ~ [Feriod

GiaphTtle  [Statistcs I~ Gave Graph

Group setings
¥ Group! I~ Group2 I~ Group3 I~ Groupd I~ Groups

Image Map setings

Shage [ |

Other sttings

Terget

Image as menu k.

| Aebes

“Blank. out the image, i requied.

ok | con





Note:

1. Add to all and Delete From all option is available for Function Menus only.

2. The Properties button invokes the relevant properties dialog depending on the selected menu option’s Action.

3. Full Report and Full Graph options are available on Record Function and Non-Function Menus only. Full implies ignore Record PIDs.
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Graph menu option on Record function menu is termed as Graph Blob. This abides by the Record's PIDs when generating graph. Save Graph option is not available on the Graph Properties dialog when adding Graph menu option to Record function menu. 

Report Interval Definition XE "Thin Client Designer:Menu Designer: Report Interval Definition " 
Setting the Report Interval is one of the requirements of X-Web reporting. The Report menu option lists unique IDs which identifies the report interval under Date Totaling column, besides other options. This information is held in the report interval file, XRPTINTVL, in application Library.

The STRTMNTH & ENDMNTH fields in XRPTINTVL relate to start & end months respectively and can have values 1-12 and the special values 0 & -1 (explained below)

The STRTDATE & ENDDATE fields in XRPTINTVL relate to start & end dates respectively and can have values 1-28, 29?, 30?, 31? And the special values 0 & -1 (explained below)

RCLASS is reserved for future use

RTYPE can be Y in which case it indicates that the report interval is to be subset to consist of records pertaining to the current year only.

Usage scenarios:

1. User wants a report for current month and the corresponding values in past years:

STRMNTH=-1 (current month)

STRDATE=0 (1st day of STRMNTH)
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ENDMNTH=-1 (current month)

ENDDATE=0 (last day of ENDMNTH)

2. User wants year-to-date total for this year and compare it with ytd of previous years on the same date:

STRMNTH=0 (disregard – hence means start from January)

STRDATE=0 (1st day of STRMNTH)

ENDMNTH=-1 (current month)

ENDDATE=-1 (current date)

3. User wants total for period from 11th May to current date along with past years:

STRMNTH=5 (May)

STRDATE=11 (11th day of STRMNTH)

ENDMNTH=-1 (current month)

ENDDATE=-1 (current date)

4. User wants total for period interval 17th October to 23rd December

STRMNTH=10 (October)

STRDATE=17(17th day of STRMNTH)

ENDMNTH=12 (December)

ENDDATE=23 (23rd day of ENDMNTH)

So, to generalize on the meaning of 0 & -1:

	FIELD
	VALUE
	MEANING

	STRMNTH
	0
	January

	STRMNTH
	-1
	Current month

	STRDATE
	0
	1st of month

	STRDATE
	-1
	Current date

	ENDMNTH
	0
	December

	ENDMNTH
	-1
	Current month

	ENDDATE
	0
	Last date of month

	ENDDATE
	-1
	Current date


Setting a value of STRDATE=-1 implicitly implies that STRMNTH=-1 so even if STRMNTH is not -1 the STRMNTH value will be assumed to be -1. The same relationship exists between ENDDATE & ENDMNTH.

The Function Designer provides an option to add/edit/update reporting intervals. The option under Design Menu, X-Web Report Intervals, brings up the dialog as shown.

Job Scheduler XE "Thin Client Designer: Job Scheduler " 
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Jobs like Reports and Graphs can be scheduled using the Job Scheduler. The Design menu option, Scheduled Jobs brings up the Job Scheduler.

This has two sections: 

· Section one has a table listing the scheduled jobs 

· Section two is the Edit panel to add new jobs or update/delete the existing jobs 

The first section lists the scheduled jobs detailing each job's 

· Description 

· Job type 

· Job's scheduled Date and Time 

· User details who scheduled the job 

· User details who rescheduled the job, if any 

The first row defaults to "Add New Job". 

The edit panel allows adding of the job if the first row is selected on the list. Any other row selection on the list opens that job in update mode.


The user needs to supply the following inputs: 

· [image: image181.png]& 4




Select the job type from Report, Graph and Graph Blob. This fetches the unscheduled jobs of the type selected.

· Select the job to schedule.

· Change the scheduled job's text, if required. 

· Choose job's Day/Date. (Options follow the priority as listed) 

· Every Day 

· Day of the week 

· Day of the month 

· Specific date (Supply date in the site's date format. Default: DD-MM-YY) 

· Job time. The time should be in 24 hour format (HH:MM or HH:MM:SS) 

The edit panel has four buttons: 

· Add 

· Update 

· Delete 

· Cancel 

Add Button is enabled only when adding a new job. Update and Delete buttons get enabled when working with an existing job. 

Blob Manager XE "Thin Client Designer:Blob Manager " 
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Blob is nothing but the image attached to a particular record. E.g. the image of the product next to its description. Blobs can be maintained using the following option available only on the Grid display.

The Grid display Toolbar item [image: image113.png]


 (File > Maintain Blobs option) invokes the Blob Manager. The Manager is quite like the Descriptor Dialog. Besides listing the PIDs and the description field of the record, name of the image attached to the record is also shown under the Blob Name column, if any.

To add, update or remove image for a record, click on the Blob Name cell for the record. This makes the cell editable. The user can now supply the name of the image (100 characters long). The existing names, if any, can be changed or removed.


Press the Save Button to save changes. 
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If number of records is large, the Navigation keys and Position To can be used to reach the required record.

User Profile Manager XE "Thin Client Designer:User Profile Manager" 
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User profiles can be maintained from the Design menu of the Flat screen or Grid’s menu bar. This action is only available to the user having the authority to view the user profiles i.e. the user profile must have design level and security level as A in XUSRPRF File.

If the user has design level as A but the security level is blank, then the user can enter the design mode but cannot view the user’s profile. The user profile menu option is present in the Design menu. When the user selects the User Profile menu option, the following window appears.

The Manager has two sections: 

· Section one has a table listing the User Profiles 

· Section two is the Edit panel to add new profiles or update/delete the existing ones 

The first section lists: 

· User Profile - Only valid AS/400 profile can become a User profile 

· Design Level - A is the highest 

· Security Level - A is the highest 

· Start Page for the user 

· Selection Keys for the start page, comma separated 

· Number of Keys to Prompt 

· Selection mode - As *SCRIPT Popup(Default)/*PROMPT Form, on X-Web 

· Application Library - If starting X-Web from a page in another application library. 

· Help Default - Brings up help on each X-Web page, if checked. 
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User KeyList - Upto 5 combinations of comma separated keys are possible, to help restrict records access. 

The first row on the table defaults to "Add New Profile". 

The edit panel allows adding of the Profile if the first row is selected on the list above. Any other row selection on the list opens that Profile in update mode.

The edit panel has five buttons: 

· Work with Additional members 

· Add 

· Update 

· Delete 

· Cancel 

Add Button is enabled only when adding a record. Update and Delete buttons get enabled when working with an existing record. Work with Additional members takes the Designer to the Member information Maintenance Manager.
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Member Information Manager XE "Thin Client Designer:User Profile Manager:Member information" 
This lists all the existing members. This is almost same as the User Profile dialog except for that the list here displays the User Profile for each member.


Further the Edit panel has Password/ Confirm Password fields and a User Profile dropdown to pick a User profile for a member.

The Cancel button takes back to the User Profile Manager

Glossary XE "Glossary" 
Active Fields: Currently visible fields on the screen.

Alternate Functions: These are screen designs other than the current one showing records with the same access path as the current screen.

Application Library:  The primary database/library Function Designer consults for starting the application. This database/library contains files for screen (function) definitions and function layout details.

Code Field: A field property which indicates whether this field has limited set of predefined values which can be displayed along side for selection (Code Field value=‘Y’), or range (Code Field value = ‘R’) . 

Comment: This is a text that the user enters for a particular database record. The comment is tagged with user Id (who wrote the comment) and the date and time of writing the comment.

Comment Text: Text attached to a comment.

Data Mining: The process of discovering correlations, pattern, & trends by digging into  (analyzing) large collection of data.

Data Modelling: The process of representing and analyzing relationships discovered through the process of datamining into user-friendly diagrams, charts or databases. Databorough has specialised tools for datamining and datamodelling, both of which are completely automated.    
Database File: Database table that contains designer data.

Dependent Function Record: A row or a record of the dependent function.

Dependent Functions:  Function, which has the same set of keys as the primary identifiers of the owner function. 

Dependents: Files or tables, which have the same set of keys as the primary identifier of the present table.
Descriptor: A text field in a foreign file that describes a field in the present file.

Descriptor Dialog: A dialog to display field and its description in the form of grid.

Designer Mode: Mode, which can be used to change the layout and other properties of display.

Display Length: Number of characters field visible on display. 

Driver: Interface used by an application to communicate with the database.

Edit Code: Editing fields according to a pre-defined pattern.

Equal Keys: Higher level keys of the current access path , whose values are fixed from the owner function .Since their values are fixed these fields are either shown as un-editable or hidden.

Exit Routines: The Exit Routines are the designer written programs or any other programs to which designer wants to transfer the control so that further tasks can be performed by this routine. 

Field: A column of data base file.

File: A database table or any logical view of database tables.

File Selection List: A list of all the database files and functions in the database.

Filter Criteria: A set of conditions to select records form the database based on these conditions.  

Filter Dialog: A dialog used to take input from the designer for filtering records.

Flat Screen: A single record display from the database.

Flat Screen Function: Layout of single records on screen stored in file that is used to present record(s) on the screen.  

Flip Orientation:  To change the orientation from horizontal to vertical or vice versa.
Foreign Keys: The fields that are used to join to key fields in another database file.

Function: Layouts of screen that are used to present data on the screen. 

Grid: A tabular representation of database file. 

Heading: A unique grouping of comments identified by unique name.

Hidden Keys: same as equal key.

Indirect Relns: ->Specialty of Databorough tools.

These are the relationships between two database files or tables that require a third or more files to provide specific key information to complete the join.

JDBC Driver JDBC technology compliant database driver. 

Join Constants: Join constants are the constants used in Join condition between two files. The join constants form part of composite key in joining the two tables for refers-to relationship. This means instead of a foreign field involved in a join, a constant value is used for making the join.

Journal: A term used to indicate a transaction log for the current database file or table. For this to work the database manager should have transaction logging enabled.

Keys: Field or combination of fields having to identify records of a file uniquely.

Library List: List of databases/libraries on DBMS that would be searched in the order specified for any database object or shadow program. 

Lookup By: List of different logical views on the same database file/table. 
PID: Primary Identifier, used to uniquely identify a database record. E.g. PID0, PID1...

Position Keys: set of keys whose values can be used to locate a record in a table.

Potential Fields: The fields existing in the database file but currently not displayed on the screen that can be added to visible fields by field inclusion tab.

Potential dependent functions: The functions based on files other than the current one which can be shown as dependents (share the same higher level keys) to the current file, but are not shown in the current list of dependents.
Potential Alternate Functions: Same as Alternate Functions but not included in the current list of Alternate Functions to the current Function.
Prompt Keys Dialog: Dialog used to input prompt key values.

Prompt Keys: The key fields value with which designer would subset the file in grid view.
Rebuilt Function: If rewriting function file with current display properties.

Reverse Engineering: The process of bringing back the information provided in the analysis and design phase of the project.

Screen Definition: Display representation of database file.

Session Field: Session fields are used to place data on screen that is pertinent to the application or the session rather than the function.
Site Library: The library containing the files pertaining to a site.

Site Variable: Variable specific to site and maintained in Site#. properties file (#=1,2,3…).

Specs: Serialized files that store the function (screen) definition of the corresponding function.
Specs Path: Location where Specs files are stored.
Surrogate Keys: Auto generated key to identify each Heading associated with each record.

System URL: URL to access database residing any where on the network.

Totaling:  display of totaling rows along with the database records in a Grid display. 

Totals Only: display of totaling rows only.

Totaling Field: A numeric field on which totaling is performed.
User Id: User name identified by database system to provide access to database files.

User Mode:  Mode in which the designer wants to view the flat screen. 

View: Different logical representation of database file(s) with different keys. 

Visible Columns: Fields currently visible on the display.

Work Field: A field whose value is calculated on the basis of a formula or an expression.
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X-Browse
Entry Dialog, 11

Features, 4

From X-Analysis, 12

User Options, 12





















Send Mail

















Email composition Area





View Document



































View Mail























Create Document






































Tag Palette


























© Copyright Databorough Ltd. 2005



[image: image187.png]File Wiew LookupBy Act
NewWindow

il Fies
Data Dictonay Fies
Dther Files

Schedued Jobs
Retun

Clear cache.

Esit




[image: image188.png]Design History Help
Curent Function
Select Function
Rename Function
New Function
Delete Furnction

Rebuid Function
Refmat Function

P

Xwieb Report Intervals
Apply Theme and Logo
Create Custom Theme.

Define Mai Template

Non Function Menus... »




[image: image189.png]e e [l S el [ b [l S [t

User
NEWUSER 0
us A A 0
XWEB A A AADISTS DT 0 “SCAIPT
UK A A 0
Kl
User Designlevel | SecuityLevel [

Start Page: Start Page Selection Keys Keys toprompt. [0

Selection Mode [*SCRIPT 7| Applicaton Libray Help Defaut

Group Fiter Nare User Emai ¢

Group Fiter Nare: Select < User Emaild

Ui Keyliss
“UKLIST1 “UKLIST2 “UKLIST3 [
ursre ursrs

Wl i odond et | \ Cood




[image: image190.png]UserName UsetProfie [ Statt Page [ Start Page Selecion Keys | Keys to rompt | Selecton Mode | Application Lay [ Help Defaui
NEWUSER “USER 0 N
B XWER 0 “SCRIPT N

Confim Password

e 4

Keys to prompt

Help Defaut 1™

User [ Password
SttPege USRSt Poge Selcion s
Sectiniiede [SCFT] sopcston iy
sl [0 = —
s Key L
st stz
st TS

kwsa

Add

{| oz ez

Cancel




